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1 Quick Start  

This Quick Start section is intended to provide a brief overview of how to download, install and 
start grouping using the HRG4 Grouper application.  It is designed to provide enough 
information to quickly start grouping relatively small amounts of data.  For a more detailed 
understanding, it is advised that the full reference manual is read before using the grouper 
application. 
 
 

1.1 Download and Install the Grouper 

 
1) Visit the downloads section of the Casemix Service website 

www.ic.nhs.uk/casemix/downloads 

2) Click on either Payment or Costing 

3) Click on the link for the grouper application 

4) Click on the grouper application link in the Download section at the bottom of the screen 

5) Save the Zip file to an appropriate location on your computer 

6) Open the Zip file and extract the grouper application 

7) Double-click the grouper application file and follow the installation setup wizard 

 

 

1.2 Grouping Walkthrough Using Sample Data 

The following walkthrough describes the process of grouping a sample input data file which 
can be downloaded from the Casemix website. 
 

1) Download the sample input data file from the casemix website: 

 www.ic.nhs.uk/hrg4groupermanual 

2) Open the grouper application.  

3) Select Admitted Patient Care HRG4 in the Database: drop-down list: 

4) Click the „Browse…‟ button next to „Record Definition File‟.  

 

 

 

 

 

 

 

 

 

 

 

 

5) In the „Open‟ form, browse for the Sample RDF „HRG4_sample_APC.rdf‟.  

 The default location for Sample RDFs is within C:\Program Files\NHS IC\  

 

http://www.ic.nhs.uk/hrg4groupermanual
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6) Open HRG4_sample_APC.rdf 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

7) From the Tools menu select Process File…  

8) Click the Browse button (folder icon) to the right of the „Input File‟ field.   

9) In the „Open‟ form, browse to and select the downloaded Sample Input Data File. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10) Click Open 

11) Tick the Input data has headings check box.  

12) Click the browse button (folder icon) next to the Output File field. 

13) In the Save As form, browse to the folder containing the input file and type „output‟ in the 

File name box.  

14) Click Save.  
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The path and filename of the output file will be displayed in the „Output File‟ area (above) 

 

15) Tick the Add headings to output data checkbox. 

16) Click Process (This initiates HRG grouping). 

 

A progress bar shows the file being sorted followed by the percentage complete.  The 
application will return to the main screen on completion.  
 
The Log Display Area (below) shows the status of the grouping session, including the number 
of records grouped 
 

 

17) Open Windows Explorer and browse to the folder specified for the output file.  

18) Open output_FCE.csv in Microsoft Excel.  The file is a copy of the input data file with 

HRGs and other related columns appended. 

19) Scroll to the far-right of the file to see the columns that the grouper has appended. 
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1.3 Grouping Your Own Data 

 

Successful grouping is dependent on the compatibility of the Input Data File, the selected 

Database and Record Definition File (RDF).  Users can either prepare an Input Data File 

which  matches an existing Sample RDF (supplied as part of the grouper installation), or use 

the Record Definition File Wizard in the grouper application to create a Custom RDF that 

matches the Input Data File.  

 

Method 1:  Create Input Data File to match Sample RDF 
 

1) Open the grouper application 
2) Select File > Open RDF… and browse the grouper installation folder for the appropriate 

Sample RDF. For an Admitted Patient Care (APC) data file, select 
„HRG4_sample_APC.rdf‟. 

3) Ensure that the field positions in the input data file match those specified in the selected 
RDF. If the field positions in the input data file do not match exactly the data will be 
grouped incorrectly. Descriptions of the field names are provided in Section 2.3: Input 
File Definition Tables of the HRG4 Grouper Reference Manual. 

4) When a compatible Input Data File has been prepared it can be grouped by following 
the „Grouping Walkthrough Using Sample Data‟ and substituting the Sample Input Data 
File for the prepared Input Data File. 

 

Method 2:  Create Custom RDF to match Input Data File 
 

1) Select File > New RDF to open the Record Definition File Wizard 
2) Select Database for the  type of data you are using (e.g. Admitted Patient Care (APC)) 
3) Select method of creating the RDF: 

a. ‘Create fields manually’ displays a grid in which the corresponding numerical 
field position values can be assigned to the required fields.  

b. ‘Create from a sample file’ creates an RDF using the required Input Data File.  
When selecting this option the first row of the selected input data file is displayed in 
the preview window, with temporary field names („Field 1‟ etc.) immediately above it.  

4) Fields can be assigned by dragging the field name from the list to the appropriate field in 
the preview area.  

a. All entries in the Mandatory Fields list must be assigned to fields in the Input 
Data File. 

b. Multiple fields can be selected by holding SHIFT and/or CTRL and dragging the 
selected fields into to the preview area.   

c. To remove an assigned field, select it in the Assigned Fields list and press 
„Delete‟. The field will be moved to the bottom of the Mandatory Fields list.  

5) When all fields have been assigned, click „OK‟. The RDF will be opened in RDF Editor 
for checking/amendment. 

6) Save RDF in desired location 
7) When a valid RDF has been created, data can be grouped by following the „Grouping 

Walkthrough Using Sample Data‟ and substituting the Sample RDF for the Custom 
RDF. 
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2 File Preparation 
 
Data must be prepared in accordance with the following Input File Definition tables to ensure 
that correct HRGs are derived and to avoid the grouper returning errors.  Good preparation of 
Input data and an understanding of the issues associated with different types of data can save 
time and ensure successful grouping runs. 
 

2.1 Input Data 

The grouper application can only process input data files containing a single activity type due to 
the differences in data items required by each input file type to assign HRGs.  Files with a 
combination of activity types cannot be processed.  The grouper includes HRG definitions for 
the following types of activity: 
 

 Admitted Patient Care 

 Non-Admitted Consultations 

 Emergency Medicine 

 Adult Critical Care 

 Neonatal Critical Care 

 Paediatric Critical Care 

 Renal Dialysis (National Renal Dataset) 
 
File Format 
Input data must be in CSV format (comma-separated text) using the standard American 
Standard Code for Information Interchange (ASCII) character set, excluding the non-printing 
ASCII characters.  The input file must not include qualifiers, such as quotes, surrounding the 
fields. 
 
Using Excel for File Preparation 
If some of the records end with empty fields then a file structure issue can arise when saving a 
text file using Microsoft Excel (For more information please refer to Microsoft Article ID 77295 
“Column delimiters are missing in an Excel spreadsheet that is saved as text”). To prevent this 
issue arising, ensure that the final (rightmost) column of data is populated for every record in the 
file with „dummy data‟ such as “x”. 
 
Field Order 

The input data field listings in this document are not intended to imply a field order for the input 
data; the field order of the input data is specified in the RDF. Where one of the sample RDFs 
supplied with the grouper installation is used, the input data field order must match the order in 
the sample RDF. 
 
Chemotherapy and Radiotherapy  
Data required for the derivation of HRGs for Chemotherapy and Radiotherapy treatments may 
not be captured in the local Patient Administration System (PAS). Where these types of data are 
collected in specialist departmental systems only, local arrangements will be required to ensure 
that the data can be incorporated into admitted care or outpatient datasets for HRG grouping.  
Users must ensure that input data files contain appropriate records as specified by Department 
of Health Payment by Results guidance. 
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2.2 Data Validation 

Three stages of validation are applied to the data during a processing run to ensure the data are 
valid and within expected value ranges. They are: 
 

 Field values within a record 

 Cross-validation of related records (e.g. consultant episodes within a spell) 

 Grouping logic 
 
An HRG code of UZ01Z, Data Invalid for Grouping is returned in the output record if data 
validation is failed.  If there are errors in the input data these will be reported in the 

_quality.csv output file.  There may be more than one reason why an HRG cannot be 

assigned and each row in the _quality.csv file may contain several error messages, all of 

which need to be addressed to allow the record to be grouped. 
 
Completeness of Records 

It is the responsibility of the user to ensure that each record contains all fields listed in the RDF 
as the grouper cannot detect whether specific fields are missing from an input data file.  All 
records within an input file must contain the same number of fields.  Where fields are not 
populated (e.g. where there are fewer procedure codes than available fields), the commas that 
delimit the fields must still exist in the file to represent the empty fields.  
 
Validation of Clinical Codes (Procedure and Diagnosis codes)  

„Points‟ must be removed from clinical codes because clinical code validation rejects any clinical 

code containing a point. For example, „F15.2‟ would rejected by the grouper whereas „F152‟ 

would be valid.  

 

To remove points from clinical codes, either: 

 Use the grouper‟s „Extract‟ feature to remove them during processing (See Section 3) 

 Remove the point from each code in the input data prior to processing 
 
Approaches and Sites 

Within the HRG definitions there are situations where the assignment of an HRG based on an 

OPCS-4 code depends on the presence of other OPCS-4 codes, indicating approach or site. 

Such codes should always appear immediately after the procedure to which they relate unless 

national clinical coding guidance specifically states otherwise. The grouper does not apply a 

single site code or approach code to a group of procedures. 

 

Episode Number Procedure 1 Procedure 2 Procedure 3 Procedure 4 

1 J104 Z393 J118  

2 J106 J104 Z393  

3 J106 Z393 J104 Z393 

 

In the second episode above, the site recorded as Z393 “Portal vein” is taken to refer only to the 

J104 angioplasty procedure and is not applied to the J106 thrombolysis procedure. If both 

procedures are performed on the portal vein then the record must be recorded as shown in the 

third episode. 
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2.3 Input File Definition Tables 

The following input file definition tables contain a „Validation/Notes‟ column. In many cases the 
validation column refers to „valid national code‟.  Lists of national codes are available from the 
NHS Data Dictionary.  
 

2.3.1 Admitted Patient Care 
The grouper automatically sorts APC data prior to processing so that records with the same 
Provider Code and Provider Spell Number are placed in Episode Number order, improving 
spell-level processing speed.  The NHS Data Dictionary states that "A known EPISODE 
NUMBER can be between 01 to 87".  Spells containing more than 87 episodes are not 
recognised by the grouper. 
 
The Admitted Patient Care input file definition table below displays the fields required by the 
grouper.  The field order of the input data file is defined by the RDF being used for the grouping 
session.  There is no significance to the order in which the fields are listed below. 
 

Field Name Description Format Validation/Notes 

PROCODET Provider Code an8 

The provider Organisation Data Services 
(ODS) code is recommended 

Maximum length 8 characters.  

Any characters in excess of 8 are ignored in 
sorting and may result in incorrect grouping 

A value must be supplied 

PROVSPNO 
Hospital Provider 
Spell Number 

an24 

Local Spell Identifier 

Maximum length 24 characters 

Any characters in excess of 24 ignored in 
sorting, possibly causing incorrect grouping 

A value must be supplied 

EPIORDER Episode Number n2 
Range: 1 - 87 

Must be distinct within Provider Spell 

STARTAGE StartAge n3 

Start Date of Episode - Person Birth Date 
(integer whole years) 

Range: 0 - 130 

The increase between episodes relative to 
episode duration is validated 

SEX Sex n1 
Valid national Person Gender Code 

Value must be same for all FCE in Spell 

CLASSPAT 
Patient 
Classification 

n1 Valid national code 

ADMISORC 
Source Of 
Admission (Hospital 
Provider Spell) 

n2 

Valid national code 

Value must be the same for all episodes 
within Provider Spell 

ADMIMETH 
Admission Method 
(Hospital Provider 
Spell) 

n2 

Valid national code 

Value must be the same for all episodes 
within Provider Spell 

DISDEST 

Discharge 
Destination 
(Hospital Provider 
Spell) 

n2 Valid national code 

DISMETH 
Discharge Method 
(Hospital Provider 
Spell) 

n1 Valid national code 
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Field Name Description Format Validation/Notes 

EPIDUR Episode Duration n5 
Range: 0-99999 

Whole days 

MAINSPEF 
Main Specialty 
Code 

n3 Valid national code 

NEOCARE 
Neonatal Level of 
Care 

n1 

Valid national code or blank. 

8 [Not applicable] may be used, or blank, if 
not relevant. 

TRETSPEF 
Treatment Function 
Code 

n3 Valid national code 

DIAG_01 
Primary Diagnosis 
(ICD-10) 

an5 

Valid ICD-10 code (excluding decimal point 
character and any dagger/asterisk suffix). 

Decimal points are not accepted. 

Any dagger/asterisk suffix must be 
removed. For example, use A170 rather 
than A17.0† or A17.0D 

DIAG_02 - DIAG_99 
Additional 
diagnoses 

an5 

As above or blank. 

Not all fields are present by default; the 
number of fields may be specified by the 
user in the Record Definition File. 

OPER_01 - OPER_99 
Procedure Codes 
(OPCS-4) 

an4 

Valid OPCS-4 codes (excluding decimal 
point character) or blank. 

Decimal points are not accepted. For 
example, use F343 rather than F34.3. 

Not all fields are present by default; the 
number of fields may be specified by the 
user via the Record Definition File. 

CRITICALCAREDAYS Critical Care Days n5 

Range: 0-99999 or blank. 

Non-numeric characters are treated as zero 

Blank or zero where the user has already 
removed Critical Care days from the data or 
where there are no Critical Care days. 

REHABILITATIONDAYS Rehabilitation Days n5 

Range: 0-99999 or blank. 

Non-numeric characters treated as zero. 

Used in the output as the per diem 
multiplier for rehabilitation HRGs and 
deducted from episode duration prior to 
HRG derivation. 

SPCDAYS 
Specialist Palliative 
Care Days 

n5 

Range: 0-99999 or blank. 

Non-numeric characters treated as zero. 

Used in the output as the per diem 
multiplier for Specialist Palliative Care 
HRGs and deducted from episode duration 
prior to HRG derivation. 

 
Each row of data in the grouper input file represents an episode. All records with identical 
values for the Provider Code and Hospital Provider Spell Number are considered to be part of 
the same spell.  Spell-level processing is carried out on all episode records within the spell.  
 
Provider Code (PROCODET) 
Provider Code identifies the provider organisation for each record is and this is used in data 
sorting. It is strongly recommended that the organisation‟s Organisation Data Services (ODS) 
code is used. Correct use of this field is particularly important where a data file contains records 
from more than one provider.  The maximum length of the Provider Code field is eight 
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characters. Any extra characters will be ignored in sorting and this is likely to result in incorrect 
HRGs being allocated. 
 
Hospital Provider Spell Number and Episode Number (PROVSPNO, EPIORDER) 
The grouper assigns HRGs at episode and spell level.  All records are episode level.  The link 
between episodes in the same spell is made by matching Provider Code and Hospital 
Provider Spell Number.   
 
Where source data systems do not provide Hospital Provider Spell Number and Episode 
Number (or equivalents) then a proxy will be required in these fields within the submitted file.  
For Episode Number a simple incremental count may be used.  A proxy Spell Number can be 
created by either of the following methods: 
 

 Concatenate local patient identifier, Admission Date and Admission Time to create a 

proxy spell number. Admission Time is suggested in order to identify separate spells 

starting on the same date.  

 Where unique episode identifiers are assigned then use the first episode identifier within the 

spell as the Spell Number. 

 
The maximum length of Hospital Provider Spell Number is 24 characters. Any extra 
characters will be ignored in sorting and are likely to result in incorrect HRG allocation. 
 
StartAge (STARTAGE) 
This is the patient age in whole years at the start of the episode.  It should be an integer value of 
whole years rounded down. For babies and children under one year of age, the age value 
should be zero (HES baby age codes are not accepted). 
 
Sex (SEX) 
The grouper accepts the values 0, 1, 2, 9 as valid (NHS Data Dictionary Person Gender Code). 
However, where Sex is a determinant of the HRG, the value must be either 1 or 2 (male or 
female) for the correct HRG to be assigned. 
 
Patient Classification, Source of Admission, Admission Method (CLASSPAT, ADMISORC, 
ADMIMETH) 
Patient Classification, Source of Admission and Admission Method must be consistent 
between all episodes within a Hospital Provider Spell as per the NHS Data Model. 
 
Discharge Destination and Discharge Method (DISDEST, DISMETH) 
Derivation of some HRGs is influenced by Discharge Destination and Discharge Method.  
Some hospital computer systems use default values (typically the values that represent „Not 
Applicable‟) for Discharge Destination and/or Discharge Method within multi-episode spells.   
 
When grouping multi-episode spells, the grouper uses Discharge Destination and Discharge 
Method from the final episode in the spell.  To ensure correct grouping of multi-episode spells, 
the final episode of the spell must contain the actual discharge details for the spell. 
 
In episode grouping, the grouper uses Discharge Destination and Discharge Method from the 
episode being grouped. To ensure correct grouping of episodes, all episodes within multi-
episode spells must contain the actual discharge details for the spell. 
 
Neonatal Level of Care (NEOCARE) 
Neonatal Level of Care is used by the grouper to allocate the HRG for Neonatal Critical Care 
Retrieval (XA06Z). When a patient is not neonatal, a value of 8 (Not applicable) may be 
supplied or the field may be left blank. 
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Clinical Codes 
Interventions and procedures must be coded as OPCS-4 codes. Diagnoses must be recorded 
as ICD-10 codes.  The grouper does not accept decimal points in clinical codes. For example, 
F343 is considered valid but F34.3 is not.  
 
Diagnosis: the ICD-10 Dagger and Asterisk System 
ICD-10 uses Dagger and Asterisk codes to capture information about both an underlying 
generalised disease and a manifestation in a particular organ or site.  Hospital computer 
systems have various ways of representing Dagger and Asterisk and may append the 
characters „D‟, „A‟, „+‟ and „*‟ to the ICD-10 code.  
 
The grouper does not accept diagnosis codes containing these appended characters and will 
create a validation error if any are encountered. Any characters used to represent Daggers and 
Asterisks should be removed from diagnosis codes prior to grouping.  The grouper‟s internal 
logic will identify these codes for the purposes of HRG grouping.   
 
Episode Duration (EPIDUR) 
Episode Duration is the number of days in the episode. It must be derived prior to the record 
being submitted to the Grouper in line with the following calculation: 
Episode End Date - Episode Start Date (in days). 
 
Reducing Episode Duration 
The Department of Health Payment by Results guidance may require episode and Hospital 
Provider Spell duration to be reduced by the number of days allocated to certain unbundled 
HRGs. An example being unbundled HRGs that are generated on a per diem basis such as 
those for Rehabilitation. For more information, please refer to the DH Payment by Results 
guidance (www.dh.gov.uk). 
The grouper facilitates the subtraction of days for Critical Care, Rehabilitation and Specialist 
Palliative Care from Consultant Episode and Hospital Provider Spell durations. 
 
Exclusion of Critical Care Activity 
The information below relates specifically to calculating the critical care days to be subtracted 
from episode duration for HRG grouping.  It is not intended to inform the calculation of the 
number of critical care days for other purposes. 
 
The reason for excluding critical care days from admitted patient care data is to avoid 
duplicating activity in the two data types. Inpatient and critical care takes place concurrently 
within critical care periods from a data perspective. For patients having critical care period(s), 
the inpatient and critical care data are eligible for HRGs but the duration of the inpatient HRGs 
must be reduced because the unbundled critical care HRGs account for some or all of the days 
in hospital. This principle applies to adult, paediatric and neonatal critical care activity. 
 
Before making adjustments, users should ensure that subtracting critical care days from the 
Consultant Episode and Hospital Provider Spell Duration is in line with current Payment by 
Results guidance. 
 
It is possible for either the Critical Care Start Date or the Critical Care Discharge Date to be 
different from the Episode Start Date or the Episode End Date. This means that care must be 
taken in calculating how many days within an episode and spell have been spent in critical care. 
 
Critical care days are calculated on bed days, so each day that a patient is in critical care is 
included in the calculation of the duration of the critical care period. This means that, unlike 
episode duration, a critical care period duration of zero days is not possible. 
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The critical care days to be excluded from the episode duration are those that occur: 

 On or after the episode start date 

 On or before the episode end date 
 
Care should be taken to avoid counting days twice when calculating the critical care days to 

subtract from episode duration for HRG grouping. Where a critical care period ends and another 

starts on the same day, that day should be subtracted only once.  

 
In hospital computer systems, critical care period records may be allocated to specific admitted 
patient care episode records for data storage purposes. The exclusion of critical care days for 
grouping is not related to the way in which critical care period records are stored but is 
determined by the dates that the patient is in critical care and the start and end dates of the 
concurrent episodes. 
 
For reference costs, the minimum episode duration for an ordinary admission is one day. This 
means that, for ordinary admissions (Patient Classification=1) in reference costs, where the 
removal of critical care days results in a value of zero or a negative number then the result 
should be rounded up to a duration of one day. 
 
Example Calculations 
Example 1: A single day in critical care at the start of a single episode 
The patient is in critical care during the first day but leaves critical care before the end of the 

day. The stay in hospital extends over two nights. 

 

 02/06 03/06 04/06 

Episode 1        

CC period 1        

CC day count  1    

 

 The episode starts on 2nd June and finishes on 4th June so the episode duration is two days 

 The total number of critical care days is one 

 The adjusted episode duration is therefore one day (2-1=1) 
 
Example 2: No break in critical care 
In the example illustrated below, the inpatient episode starts on 2nd June and finishes on 11th 

June and thus the episode duration is nine days. There are three consecutive critical care 

periods. The total number of days spent in critical care is eight. The adjusted episode duration is 

therefore one day (9-8=1). 

 

 02/06 03/06 04/06 05/06 06/06 07/06 08/06 09/06 10/06 11/06 

Episode                     

CC period 1                     

CC period 2                     

CC period 3                     

CC day count   1 2 3 4 5 6 7 8   
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Example 3: Breaks in critical care 
Although the hours spent in critical care are fewer in this example than in the example above, 

the total number of critical care days is the same (eight). This results in the adjusted episode 

duration being one day, as above. 

 

 02/06 03/06 04/06 05/06 06/06 07/06 08/06 09/06 10/06 11/06 

Episode                     

CC period 1                     

CC period 2                     

CC period 3                     

CC day count   1 2 3 4 5 6 7 8   

 
 
Example 4: A single critical care period spans more than one episode 
In this case a decision must be made regarding the apportionment of the critical care days that 

occur at the junction of two episodes (critical care days three and five); these days must be 

apportioned to one or other of those episodes but not both. To avoid double-counting it is 

important to ensure that any critical care day is not apportioned to more than one episode. 

Note that in situations where a critical care day occurs on the end date of one episode and on 

the start date of another episode, the Secondary Uses Service (SUS) attributes the critical care 

day to the later episode. 

 

 02/06 03/06 04/06 05/06 06/06 07/06 08/06 09/06 10/06 11/06 

Episode 1                     

Episode 2                     

Episode 3                     

CC period 1                     

CC day count   1 2 3 4 5 6 7 8   

 

In this example, the allocation of critical care days to episodes could be done using either of the 

two approaches below: 

 

1. Critical care day three allocated to episode two and critical care day five allocated to episode 

three: 

 Episode one adjusted duration: one day (3-2=1) 

 Episode two adjusted duration: zero days (2-2=0) [1 for reference costs] 

 Episode three adjusted duration: zero days (4-4=0) [1 for reference costs] 
 
The adjusted spell duration is one day (1+0+0=1) [3 for reference costs (1+1+1=3)]. 
The above is consistent with the approach taken by SUS. 
 
2. Critical care day three allocated to episode one and critical care day five allocated to episode 

two: 

 Episode one adjusted duration: zero days (3-3=0) [1 for reference costs] 

 Episode two adjusted duration: zero days (2-2=0) [1 for reference costs] 

 Episode three adjusted duration: one day (4-3=1) 
 
The adjusted spell duration would therefore be one day (0+0+1=1) [3 for reference costs 

(1+1+1=3)]. 
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It is important to note that where there is a choice of episode to which critical care days may be 

apportioned (i.e. at episode junctions), the same approach should be adopted consistently 

within spells.  Critical care days at the beginning/end of episodes should be apportioned either 

to the beginning or end of episodes but not a mixture of both. This means that critical care days 

three and five should not both be allocated to episode three in this example. 

 

Due to the different methods by which episode duration and critical care duration are calculated, 

deducting critical care days from episode duration could lead to a negative figure in some 

situations. Where this is the case in payment groupers, the adjusted episode duration should be 

recorded as zero days. Where this is the case for reference costs groupers, for the purposes of 

reference costs only, the adjusted episode duration should be recorded as one day. 

 
Automatic Adjustment for Critical Care Days 
The grouper application provides a facility to remove critical care days as part of the grouping 

process.  To use this facility the input field CRITICALCAREDAYS for each Consultant Episode 

record should be populated with the number of critical care days that are to be removed from 

that Consultant Episode‟s duration. 

 

If critical care days have already been removed from the data or there are no critical care days 

to be removed, the input field CRITICALCAREDAYS should either be left blank or populated 

with zeroes.   

 

The output field CalcEpidur contains the adjusted value.  In Reference Costs grouper the output 

field ReportingEPIDUR (blank for payment groupers) contains the adjusted value; this field has 

a minimum value of one day for ordinary admissions (Patient Classification=1). 

 

Rehabilitation and Specialist Palliative Care Activity 
The grouper input file includes the fields REHABILITATIONDAYS and SPCDAYS. These should 

be populated with the number of discrete rehabilitation days and specialist palliative care days, 

respectively, for each episode that contains appropriate activity.  These fields are used in two 

ways by the grouper: 

 

 To provide the per-diem multipliers in the unbundled HRG output for Rehab and SPC. 

 For automatic exclusion of days to avoid double-counting of activity. 
 
The fields may be set to zero or left blank for records where there are no applicable days. 

 
Rehabilitation Days 
The input field REHABILITATIONDAYS should be populated with days where discrete 

rehabilitation has taken place.  For the purposes of HRG derivation, in accordance with national 

clinical coding guidance (OPCS-4 codes U50-U54), discrete rehabilitation refers to a patient 

being either admitted specifically to a rehabilitation unit or transferred to a rehabilitation 

specialty.  This does NOT refer to rehabilitation when it is part and parcel of a normal treatment 

plan; as such activity cannot be captured using primary classifications. 

In the unlikely event that data indicate discrete rehabilitation and critical care have taken place 

at the same time, the rehabilitation days should be reduced to account for critical care days. 
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Specialist Palliative Care Days 
If the following conditions are met by a consultant episode record then an adjustment for 

Specialist Palliative Care should be made in the input field SPCDAYS: 

 

 Treatment Function Code is 315 AND Main Specialty Code is any of: 
o 315 (Palliative Medicine) 

o 950 (Nursing Episode)  

o 960 (Allied Health Professional Episode). 

 

These conditions mirror the criteria that the grouper uses to identify entire episodes of specialist 

palliative care.  

 

Unbundled specialist palliative care HRGs are also derived for episodes outside of treatment 

function code 315 where the ICD-10 code Z51.5 is present.  There should be no adjustment to 

episode duration in these cases because the HRGs derived in these cases are for specialist 

palliative care support rather than specialist palliative care.  Patients are not under the care of a 

specialist palliative medicine consultant but receiving input from a specialist palliative care 

specialist support service. 

 

The number of days to enter in the SPCDAYS field depends on whether or not the Specialist 

Palliative Care consultant episode includes critical care: 

 

 Where there is no critical care then SPCDAYS should be populated with the number of days 
of the entire episode duration. This will cause the grouper to generate one Specialist 
Palliative Care HRG for each day of the consultant episode and adjust the value of the 
output field CalcEpidur to zero. 

 

 Where there is critical care during the Specialist Palliative Care episode, the number of days 
used to populate SPCDAYS must be the episode duration minus the number of critical care 
days. This is on the basis that, from an HRG viewpoint, the patient is primarily receiving 
either Specialist Palliative Care or critical care. CRITICALCAREDAYS should be populated 
with the critical care days as described above. 
 

Per-Diem Unbundled HRG Multipliers 
Rehabilitation and Specialist Palliative Care unbundled HRGs are produced on a per-diem 

basis, i.e. one unbundled HRG per day.  Where there are multiple Rehabilitation or Specialist 

Palliative Care HRGs, instead of repeating the HRG, the unbundled HRG in the FCE output file 

is in the format:  

The HRG, followed by an asterisk, followed by the number of days.  

For example, VC18Z*20 indicates VC18Z for 20 days. The number of days for the multiplier is 

taken from the REHABILITATIONDAYS or SPCDAYS column as appropriate.  
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2.3.2 Non-Admitted Consultations 
Non-admitted Consultations are outpatient attendances or attendances by patients for nursing 
care on a ward (ward attenders). Since April 1st 2005 the Outpatient Attendance CDS has 
contained both of these types of data.  
 
The Non-Admitted Consultations input file definition table below shows the fields required by the 
grouper.  The field order of the input data file is defined by the RDF being used for the grouping 
session.  There is no significance to the order in which the fields are listed below. 
 

Field  Description Format Validation/Notes 

STARTAGE Age n3 

Range: 0 - 130 

Appointment  Date - Person Birth Date 
(integer whole years) 

SEX Sex n1 Valid national Person Gender Code 

MAINSPEF 
Main Specialty 
Code 

n3 Valid national code 

TRETSPEF 
Treatment Function 
Code 

n3 Valid national code 

FIRSTATT First Attendance n1 Valid national code 

OPER_01 - OPER_99 
Procedure Codes 
(OPCS-4) 

an4 

Valid OPCS-4 codes or blank. 

Decimal points are not accepted. 

Not all procedure fields are present by 
default:  Number of fields may be specified 
user in RDF. 

 
Each row in the input data file represents a single attendance. 
 
Diagnosis Codes 
Diagnostic coding is excluded from the HRG4 algorithm for non-admitted care and ignored by 
the grouper. 
 
StartAge 
This is the patient‟s age in whole years at the time of the attendance.  
 
Sex 
The grouper accepts the values 0, 1, 2, 9 (NHS Data Dictionary Person Gender Code) as valid 
values for Sex. Where Sex is a determinant of the HRG however, the value must be either 1 or 
2 (indicating male or female respectively) to ensure that the correct HRG is assigned. 
 
Procedure Codes 
The grouper requires any interventions and procedures to be recorded as OPCS-4 codes.  
Where no significant OPCS-4 codes are recorded the grouper logic will assign an HRG based 
on the value in the First Attendance field. 
 
The grouper does not accept decimal points in clinical codes. For example, F343 is considered 
valid but F34.3 is not. The Record Definition File „Extract‟ facility can be used to remove decimal 
points from clinical codes during file processing.  Please refer to Section 3: Using the Grouper 
for more information on the „Extract‟ facility. 
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2.3.3 Emergency Medicine 
The Emergency Medicine input file definition table shows fields required by the.  The field order 
of the input data file is defined by the RDF being used for the grouping session.  There is no 
significance to the order in which the fields are listed below. 
 

Field  Description Format Validation/Notes 

AGE* Patient age n3 
Range: 0 - 130 (Date of attendance minus 
date of birth)  Integer in whole years 

INV_01 - INV_99 
Accident and 
Emergency 
Investigation Codes 

an2 

Valid national codes or blank. 

“Investigation” part of code only. 

 “Local sub-analysis” part of code not 
accepted. 

Include leading zero if part of national code. 

Not all fields are present by default. 

Number of investigation codes specified by 
user in RDF. 

TREAT_01 - TREAT_99 
Accident and 
Emergency 
Treatment Codes 

an3 

Valid national codes or blank. 

“Condition” and “sub-analysis” parts of code 
only. 

“Local use” parts of code not accepted. 

Include leading zero if part of national code. 

Not all fields are present by default. 

Number of investigation codes specified by 
user in RDF. 

 
*AGE is validated but is not used in HRG derivation. 
 
A record containing only Accident and Emergency Investigation Code 24, „None‟ (indicating no 
investigation has taken place) will group to VB11Z, No investigation with no significant 
treatment.  Although any of the investigation and treatment fields may be left blank, a record 
where ALL fields are blank will group to UZ01Z, Data Invalid for Grouping.  The field order of 
the input data must be as defined in the RDF used for the grouping session. 
 
Investigation Codes 
The investigation fields in the A&E CDS can contain up to six alpha-numeric characters.  Only 
the two leading characters are the national code, the last four positions are locally assigned 
values. These fields must be truncated to the two leftmost characters in the input data file.  
Leading zeroes must be included where required (e.g. „01‟ is valid but „1‟ is not). 
 
Treatment Codes 
Within the Accident and Emergency Attendance CDS, treatment fields can contain up to six 
alpha-numeric characters. The code structure is: 
 

Condition n2 

Sub-Analysis n1 

Local Use up to an3 

Depending on the code, either the leftmost two characters or the leftmost three characters 
indicate the national code, with the remainder of the field containing locally assigned values. 
These fields must be truncated to the national code as appropriate in the input data file.  
Leading zeroes must be included where required (e.g. „01‟ is valid but „1‟ is not). Accident and 
Emergency treatment codes are defined in the NHS Data Dictionary. 
 
Patient Age 
Age of patient in whole years at the start date of the session. 

http://www.datadictionary.nhs.uk/data_dictionary/attributes/a/acc/accident_and_emergency_treatment_de.asp?shownav=1
http://www.datadictionary.nhs.uk/data_dictionary/attributes/a/acc/accident_and_emergency_treatment_de.asp?shownav=1
http://www.datadictionary.nhs.uk/data_dictionary/attributes/a/acc/accident_and_emergency_treatment_de.asp?shownav=1
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2.3.4 Renal Dialysis (National Renal Dataset) 
Renal Dialysis HRGs are generated using fields from the National Renal Dataset.  The input file 
definition table below shows the fields required by the grouper. The field order of the input data 
file is defined by the RDF being used for the grouping session.  There is no significance to the 
order in which the fields are listed below. 
 

Field  Description Format Validation/Notes 

RENALMOD 
Renal Treatment 
Modality 

n2 

Valid national code. 

Numbers less than 10 must include a 
leading zero. 

RENALSITE 
Treatment 
Supervision Code 

n2 

Valid national code. 

Numbers less than 10 must include a 
leading zero. 

RENALACCESS 
Type of dialysis 
access 

n2 

Valid national code or blank. 

Numbers less than 10 must include a 
leading zero. 

HBV 
Hepatitis B Surface 
Antigen Status 

a3 

Valid national code or blank. 

Must be UPPER CASE. 

Accepted values are NEG, POS and UNK. 

HCV 
Hepatitis C 
Antibody Status 

a3 

Valid national code or blank. 

Must be UPPER CASE. 

Accepted values are NEG, POS and UNK. 

HIV HIV blood test a3 

Valid national code or blank. 

Must be UPPER CASE. 

Accepted values are NEG, POS and UNK. 

AGE Patient age n3 
Range: 0 - 130 (Date of attendance minus 
date of birth)  Integer in whole years 

 
Each row of data in the input data file represents either one haemodialysis session or one day 
of peritoneal dialysis. 
 
Patient Age 
Age of patient in whole years at the start date of the session. 
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2.3.5 Adult Critical Care 
The Adult Critical Care input file definition table below shows the fields required by the grouper. 
The field order of the input data file is defined by the RDF being used for the grouping session.  
There is no significance to the order in which the fields are listed below. 

 

Field  Description Format Validation/Notes 

CCUF Critical Care Unit Function Code an2 

A national code valid for adults. 

Must be two characters. 

Include any leading zero. 

BCSD Basic Cardiovascular Support Days n5 Range: 0 - 99999 

ACSD 
Advanced Cardiovascular Support 
Days 

n5 Range: 0 - 99999 

BRSD Basic Respiratory Support Days n5 Range: 0 - 99999 

ARSD Advanced Respiratory Support Days n5 Range: 0 - 99999 

RSD Renal Support Days n5 Range: 0 - 99999 

NSD Neurological Support Days n5 Range: 0 - 99999 

DSD Dermatological Support Days n5 Range: 0 - 99999 

LSD Liver Support Days n5 Range: 0 - 99999 

CCL2D Critical Care Level 2 Days n5 Range: 0 - 99999 

CCL3D Critical Care Level 3 Days n5 Range: 0 - 99999 

CC_Start_Date* Critical Care Start Date n8 
CCYYMMDD 

(14 March 2009 = 20090314) 

CC_Discharge_Date* Critical Care Discharge Date n8 
CCYYMMDD 

(14 March 2009 = 20090314) 

 

*Critical Care Start Date and Critical Care Discharge Date fields are used to calculate critical 
care days in the grouper output file. They are not used in HRG derivation. 
 
Each row of data in the grouper input file represents one critical care period. 
 
CDS field „ORGAN SUPPORT MAXIMUM‟ is not required because it is not used in HRG 
derivation. 
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2.3.6 Paediatric Critical Care 
Paediatric Critical Care data is automatically sorted prior to grouping so that records with the 
same provider code and local identifier are placed in activity date order.  The input file definition 
table below shows the fields required by the grouper. The field order of the input data file is 
defined by the RDF being used for the grouping session.  There is no significance to the order in 
which the fields are listed below. 
 

Field  Description Format Validation/Notes 

PROCODET Provider Code. an8 

The provider‟s Organisation Data 
Services (ODS) code is 
recommended. 

Any characters in excess of eight 
will be ignored in sorting, possibly 
causing incorrect grouping. 

A value must be supplied. 

CCLocalID 

Critical Care Period local identifier. 
Identifies the records that belong 
within a Critical Care Period. Each 
Critical Care Period must have a 
different identifier. The identifier is 
repeated for daily records that 
belong in the same Critical Care 
Period. 

an8 

Should be the same for every 
daily record within a Critical Care 
Period i.e. not a unique record 
identifier. 

Any characters in excess of eight 
will be ignored in sorting, possibly 
causing incorrect grouping. 

A value must be supplied. 

CCDate 
Activity Date (Critical Care). Date 
to which the daily activity data 
relates. 

n8 
CCYYMMDD 

(14 March 2009 = 20090314) 

DISDATE 
Discharge Date (Hospital Provider 
Spell). 

n8 
CCYYMMDD 

(14 March 2009 = 20090314) 

DISMETH 
Discharge Method (Hospital 
Provider Spell). 

n1 Valid national code. 

CCUF 
Critical Care Unit 

Function code. 
an2 

Valid national code. 

The code must be two characters; 
any leading zero must be 
included. 

CCAC_01 - 
CCAC_20 

Critical Care Activity Codes. an2 Valid national codes or blank 

OPER_01 - 
OPER_20 

High Cost Drugs (OPCS-4) Codes. an4 

Valid OPCS-4 codes (excluding 
decimal point character) or blank. 

Not all fields are present by 
default; the number of fields may 
be specified by the user in the 
Record Definition File. 

The PCC MDS specifies two 
procedure codes only. 

DIAG_01 - DIAG_99 Diagnosis Codes (ICD-10). an5 

Valid ICD-10 codes (excluding 
decimal point character and any 
dagger/asterisk suffix) or blank. 

Not all fields are present by 
default; the number of fields may 
be specified by the user in the 
Record Definition File. 

 
Each row of data in the grouper input file represents one Paediatric Critical Care day. 
 



HRG4 Grouper Reference Manual v2.1.doc 

 
23 Copyright © 2011, The Health and Social Care Information Centre. All Rights Reserved. 

2.3.7 Neonatal Critical Care 
Neonatal Critical Care data is automatically sorted prior to grouping so that records with the 
same Provider Code and local identifier are placed in activity date order.  The field order of the 
input data file is defined by the RDF being used for the grouping session.  There is no 
significance to the order in which the fields are listed below. 
 

Field  Description Format Validation/Notes 

PROCODET Provider Code an8 

The provider‟s Organisation Data 
Services (ODS) code is 
recommended. 

Any characters in excess of eight 
will be ignored in sorting, possibly 
causing incorrect grouping. 

A value must be supplied. 

CCLocalID 
A unique local activity identifier used 
to identify a Critical Care Period 

an8 

Should be the same for every daily 
record within a Critical Care Period 
i.e. not a unique record identifier. 

Any characters in excess of eight 
will be ignored in sorting, possibly 
causing incorrect grouping. 

A value must be supplied 

CCDate 
Activity Date (Critical Care). Date to 
which the daily activity data relates 

n8 
CCYYMMDD 

(14 March 2009 = 20090314) 

DISDATE 
Discharge Date (Hospital Provider 
Spell) 

n8 
CCYYMMDD 

(14 March 2009 = 20090314) 

CCUF Critical Care Unit Function code an2 Valid national code. 

AGE_DAYS Patient age in days n3 
A value must be supplied. 

Age at date of activity. 

DISMETH 
Discharge Method (Hospital Provider 
Spell) 

n1 Valid national code 

GestLen 
Gestation Length (at delivery) 
measured in whole weeks 

n2 

Range: 10-49 

The number of completed weeks of 
the gestation period. 

PERWT Person Weight. n3.n3 

Kilograms, to 3 decimal places. 

Must be greater than zero kg and 
less than 10 kg. 

Leading zeroes are accepted (for 
compatibility with NHS Data 
Dictionary format). 

CCAC_01 - 20 Critical Care Activity Codes. an2 Valid national codes or blank 

 

Each row of data in the grouper input file represents one Neonatal Critical Care day 
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3 Using the Grouper 

A grouping run requires two files, an Input Data File and a Record Definition File. 
 

3.1 Input Data File 

The input data file contains the data for grouping (e.g. Admitted Patient Care episodes).  It is 
essential that an input data file is in the appropriate format and includes all fields required for 
grouping. Please refer to Section 2: File Preparation for further information. 
 

3.2 Record Definition File (RDF) 

The Record Definition File is a text file that provides the grouper with structural information 
about the positions of fields in the input file for all the mandatory fields of the relevant activity 
type.  The set of mandatory fields in an RDF is different for each data type and so users must 
ensure that an appropriate RDF is selected on each grouping run. 
 
Selecting a Record Definition File 
The grouper provides a wizard to create Custom RDFs and an editor to view and modify 
existing RDFs.  
 

 Custom RDF, created by the user; matches the field positions of the input data file. 

 Sample RDF, provided with the grouper installation.  
 
Sample RDFs are located in the grouper installation folder (typically within C:\Program 
Files\NHS IC\).  
 

Sample RDF Name Data Type 

HRG4_sample_APC.rdf Admitted Patient Care 

HRG4_sample_NAC.rdf Non-Admitted Consultations 

HRG4_sample_EM.rdf Emergency Medicine 

HRG4_sample_NRD.rdf Renal Dialysis (National Renal Dataset) 

HRG4_sample_ACC.rdf Adult Critical Care 

HRG4_sample_PCC.rdf Paediatric Critical Care 

HRG4_sample_NCC.rdf Neonatal Critical Care 

 
The field positions specified in the RDF must match the input data file exactly. For example, if 
an RDF specifies that EPIORDER is field number „3‟ then EPIORDER must be the third field in 
each of the input data file data rows.  For the purposes of grouping it is not necessary for the 
RDF to specify the position of every field in the input file.  Only the positions of the mandatory 
fields need to be specified. Please refer to Section 2: File Preparation for a list of mandatory 
fields for each data type. 
 
For certain data items, the RDF can specify the number of repeated fields that exist in the input 
file. For example, in Admitted Patient Care, the number of procedure codes listed in the RDF is 
12 by default. Where user data contains more than 12 procedure codes, additional procedure 
code fields can be included in the RDF. The number of fields cannot be decreased, only 
increased beyond the default value. The RDF wizard provides the facility to increase these 
fields if required. 
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If an input data file contains fields not specified in the RDF, the grouper will „ignore‟ them during 
processing and pass them through to the output file. The RDF Editor provides functionality to 
insert fields into an RDF, although this is not needed for grouping.  Additional input fields should 
only be inserted when using the internal file viewer to view output files, as the Display File… 
viewer only displays fields specified in the RDF.  
 

Using Record Definition File Wizard to Create a Custom RDF 
 

 Select ‘New RDF’ from the ‘File’ menu 

 Select required Database (the type of data file with which the RDF will be used) 

 Select Data Definition Method (The method by which the RDF will be created. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Data Definition Method: 
Create fields manually 
Allows the use of a grid to define field positions and attributes. Selecting this option and clicking 
the „Next‟ button opens the RDF editor grid where the fields can be manually defined. 
 
Create from a sample file (Default) 
Allows interactive creation of an RDF using a sample data file. Select and click „Next‟ to use this 
option.  Users will be prompted to browse for and open the required input data file. 
 
The first row of the selected input data file is displayed in the preview window, located towards 
the lower part of the form.  Temporary field names („Field 1‟ etc.) are immediately above it. 
 

The preview window assigns 

field positions automatically 

based on the comma 

positions in the sample input 

data file.   

Depending on the data type, 

the number of repeating 

occurrences of certain fields 

can be edited to 

accommodate the user‟s 

particular data recording 

conventions.  
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All entries in the Mandatory Fields list must be assigned to fields in the sample file. Fields are 
assigned by using the mouse to drag the field name from the list to the appropriate field in the 
preview area. Fields appear in the Assigned Fields list as they are used.  
 
Multiple fields can be selected by holding down SHIFT and/or CTRL. The selected fields can 
then be dragged to the preview area.   
 
To remove an assigned field, select it in the Assigned Fields list and press the Delete key. The 
field will be moved to the bottom of the Mandatory Fields list.   
 
When all fields have been assigned, click „OK‟ to proceed. The RDF will be opened in the RDF 
editor (see next section), allowing checking and any required amendments. 
 
 
Record Definition File Editor 
File > Open RDF and select the required file from the prompt box. 

 
The editor allows the modification of field positions and field attributes in an RDF. 
 

Field Name Field abbreviation. This is for internal use and cannot be modified. 

Field Title Field description which can be edited to display a locally-defined field name. 

Field No Field position in the input file. 

Picture 
Specifies whether specific character positions in the field are used or ignored during 
processing. See the „Picture‟ section later in this document. 

Extract 
Allows the user to specify that specific characters (in any position) in the field are 
ignored during processing. See the „Extract‟ section later in this document. 

 
The „Insert‟ toolbar button inserts a new field in the RDF. This feature is provided so that 
non-mandatory fields can be shown using the „Display File‟ feature. For the purposes of 
grouping, it is not necessary for the RDF to specify the positions of all fields in the input file.  
Only mandatory fields need to be specified. 
 
The „Delete‟ toolbar button removes a non-mandatory field from the RDF. Mandatory fields 
cannot be deleted.   
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When the RDF is saved the user will be informed if any validation checks failed, such as 
conflicting field positions. Any issues must be resolved before the file can be saved. 
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3.3 The Main Screen 

 
 
Main Menu 

Menu Menu Item Function 

File 

New RDF Opens the RDF Wizard 

Open RDF... Opens RDF for editing/review within tabbed display area 

Save Saves an open RDF (currently being edited) 

Save As... Saves an RDF with the option to rename or change location  

Exit Closes the application. 

Edit 
Insert Field Inserts new line in an RDF currently being edited 

Delete Field Deletes currently selected field in an RDF currently being edited 

Tools 

Process File... Opens the Process File form. 

Single Spell... Opens the Single Spell Grouping form 

Display File... Opens a selected file within the tabbed display area 

Run Reports... Opens the Run Reports form (Reference Costs groupers only) 

Select Database... Opens the Database Selection form. 

Help 
Latest User Manual Opens a link to the latest user manual on the casemix website 

About... Displays application version and contact information. 

 

 

Toolbar 

Icon Menu Item Function 

 
New RDF Opens the RDF Wizard. 

 
Open RDF... Opens RDF for editing/review within tabbed display area. 

 
Save Saves an open RDF currently being edited. 

 
Insert Field Inserts new line in an RDF currently being edited 

 
Delete Field Deletes currently selected field in an RDF currently being edited 

 
Process File... Opens the Process File form. 

 
Run Reports... Opens the Run Reports form (Reference Costs groupers only) 

 
Display File... Opens a selected file within the tabbed display area. 

 
Single Spell... Opens the Single Spell Grouping form 

 
 
Text boxes on the main screen are sized according to the width of the grouper window 
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Tabbed Display Area 
Shows screens that can be viewed when more than one of the following is open by selecting the 
tabs at the bottom of the window: 
 
Database Selection, Record Definition File Editor, File Display  
 
Current Database 
The current database is shown on the main screen of the application: 

 
The user must ensure that the Database selected matches the data type of the Record 
Definition File and the type of data to be grouped. Failure to ensure that the data type of the 
RDF and the database match will lead to grouping errors. 
 
The Record Definition File box indicates the currently selected Record Definition File. When the 
file is within the grouper‟s installation folder, the full path is not shown. For files in folders outside 
of the grouper‟s installation folder, the full file path is displayed. 
 
When the Record Definition File box list is dropped-down it shows Record Definition Files that 
have been used recently.  Click the browse button to locate an RDF in another folder. 

 

 
Log display area 
This area displays messages about the grouping session. 
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3.4 Process File  

Tools > Process File… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Input File  
Click the browse button (folder icon) next to the input file field to select the input data file.   
If 'Input files' are selected in the 'Files of type' list, only CSV and TXT files will be listed in the 
„Open’ form.  If the input file has a different extension, this value must be changed to „All Files‟. 
 
Input data has headings 
Check this box if the input data file includes field names in the first row. 
 
Output File 

 Defines the folder where the output files (containing grouped data) will be saved. 

 Specifies a file name prefix that all the output files from this session will share. 
 
For example, if the user enters c:\temp\output.csv then all the output files will be saved to the 
folder c:\temp\ and all output file names will be prefixed with „output’. The grouper then adds a 
standard file name suffix for each output file. 
 
Select the location and naming prefix for the output files by clicking the folder icon next to the 
output file field. Please refer to Section 5: Output Files for a list of standard output file name 
suffixes.   
 
Add headings to output data 
Check this box if the grouper should add field names for grouper-generated fields in the first row 
of the output files. 
 
Reports 
The Reference Costs grouper is the only grouper that is capable of producing reports. The 
„Reports‟ list is not available for other groupers. Select the reports required to be produced as 
part of the grouping session.  
 
Process Button 
When all selections have been made, clicking the „Process‟ button initiates grouping of the input 
file. When grouping is complete, the progress bar and the Process File form close and the 
application returns to the Main Screen. 
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3.5 Reports 

 
Only the Reference Costs grouper can produce reports. Reporting buttons and screens are 
visible in all grouper applications but are not functional.  The reports are created specifically to 
support the NHS Reference Costs process and are not intended for any other purpose.   
 
Reports are produced as XML spreadsheets which can be opened in Microsoft Excel 2002 or 
later.  The number of rows in an Excel worksheet is limited depending on the Excel version.  If 
the number of rows exceeds those permitted on the worksheet, an error message such as 
„Problems During Load‟ may be displayed.   
 
Admitted Patient Care 
Truncation  
Where the report title includes the word „truncated‟ this means that any episodes having a 
duration that exceeds the reference costs trimpoint use the trimpoint as the episode duration i.e. 
they are truncated at the trimpoint. The excess bed days report shows the total days where 
trimpoints have been exceeded. 
 
Automatic Adjustments in Admitted Patient Care reports  
During report generation, one day is automatically added to the episode duration of zero-length 
ordinary admission episodes (Patient Classification = 1). This is in line with NHS Reference 
Costs guidance.  This does not apply to daycases. 
 

Episode Reports 

Report Title Command Line Output File 

FCE Daycases by TFC and HRG4 APCFCEReport001.rgf _APCFCEReport001.xml 

FCE Daycases Diagnosis/Procedure by TFC and 
HRG4 

APCFCEReport002.rgf _APCFCEReport002.xml 

FCE Truncated Elective Inpatient Bed Days by TFC 
and HRG4 

APCFCEReport003.rgf _APCFCEReport003.xml 

FCE Truncated Elective Inpatient Bed Days 
Diagnosis/Procedure by TFC and HRG4 

APCFCEReport004.rgf _APCFCEReport004.xml 

FCE Truncated Non-Elective Inpatient Bed Days by 
TFC and HRG4 

APCFCEReport005.rgf _APCFCEReport005.xml 

FCE Truncated Non-Elective Inpatient Bed Days 
Procedure/Diagnosis by TFC and HRG4 

APCFCEReport006.rgf _APCFCEReport006.xml 

FCE Excess Inpatient Bed Days by TFC and HRG4 APCFCEReport007.rgf _APCFCEReport007.xml 

Unbundled HRG4 - Admitted Patient Care APCFCEReport008.rgf _APCFCEReport008.xml 

Truncated Non-elective long-stay APCFCEReport009.rgf _APCFCEReport009.xml 

Truncated Non-elective long-stay emergency APCFCEReport010.rgf _APCFCEReport010.xml 

Truncated Non-elective long-stay non-emergency APCFCEReport011.rgf _APCFCEReport011.xml 

Non-elective short-stay APCFCEReport012.rgf _APCFCEReport012.xml 

Non-elective short-stay emergency APCFCEReport013rgf _APCFCEReport013.xml 

Non-elective short-stay non-emergency APCFCEReport014.rgf _APCFCEReport014.xml 
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Spell Reports 

Report Title Command line Output file name 

Spell Daycases by HRG4 APCSpellReport001.rgf _APCSpellReport001.xml 

Spell Daycases Diagnosis/Procedure by HRG4 APCSpellReport002.rgf _APCSpellReport002.xml 

Spell Truncated Elective Inpatient Bed Days by 
HRG4 

APCSpellReport003.rgf _APCSpellReport003.xml 

Spell Truncated Elective Inpatient Bed Days 
Diagnosis/Procedure by HRG4 

APCSpellReport004.rgf _APCSpellReport004.xml 

Spell Truncated Non-Elective Inpatient Bed Days 
by HRG4 

APCSpellReport005.rgf _APCSpellReport005.xml 

Spell Truncated Non-Elective Inpatient Bed Days 
Diagnosis/Procedure by HRG4 

APCSpellReport006.rgf _APCSpellReport006.xml 

Spell Excess Inpatient Bed Days by HRG4 APCSpellReport007.rgf _APCSpellReport007.xml 

Note: there is no report 008 for Spells 

Non-elective long-stay APCSpellReport009.rgf _APCSpellReport009.xml 

Non-elective long-stay emergency APCSpellReport010.rgf _APCSpellReport010.xml 

Non-elective long-stay non-emergency APCSpellReport011.rgf _APCSpellReport011.xml 

Non-elective short-stay APCSpellReport012.rgf _APCSpellReport012.xml 

Non-elective short-stay emergency APCSpellReport013.rgf _APCSpellReport013.xml 

Non-elective short-stay non-emergency APCSpellReport014.rgf _APCSpellReport014.xml 

 

Non-Admitted Consultations 

Report Title Command line Output file name 

Non-Admitted Consultations (Excluding Chapter 
WF) by TFC and HRG4 

NACReport001.rgf _NACReport001.xml 

Non-Admitted Consultations (Chapter WF Only) 
by TFC and HRG4 

NACReport002.rgf _NACReport002.xml 

Unbundled HRG4 - Non-Admitted Consultations NACReport003.rgf _NACReport003.xml 

 

Adult Critical Care 

Report Title Command line Output file name 

Adult Critical Care by HRG4 ACCReport001.rgf _ACCReport001.xml 

 

Emergency Medicine 

Report Title Command line Output file name 

Emergency and Urgent Care by HRG4 (A&E) EMReport001.rgf _EMReport001.xml 

 



HRG4 Grouper Reference Manual v2.1.doc 

 
33 Copyright © 2011, The Health and Social Care Information Centre. All Rights Reserved. 

Report Production (Reference Costs Grouper Only)  
Tools > Process File… 
 
Reference Costs groupers have the option of producing reports either during processing or as a 
separate operation.  To produce reports during processing, select the required reports in the 
Process File form using the check boxes next to the report names. 
 

To produce reports based on a data file 
that has already been grouped select 
„Run Reports‟ from the „Tools‟ menu. This 
opens the Run Reports form which allows 
selection of the grouped input data file 
and the RDF used to group it.  
 
Select the required reports from the list by 
clicking the checkboxes and click the 
„Process‟ button.  It is essential that the 
file selected in the „Filename‟ box is a 
previously processed non-relational 
episode output file (the output file that has 
the name ending in „_FCE.csv‟). The use 
of other output files will result in reports 
that are either blank or contain incorrect 
figures. 

 
Reporting from a previously grouped file should only be done if the grouped file was produced 
using the same version of the Reference Costs grouper as that being used for reporting. 
 
 

3.6 Database Selection Screen 

Tools > Select Database… 
The Database Selection screen 
provides an alternative way of 
selecting the current database and 
a method for exporting database 
tables.   
 
The Table drop-down box displays 
a list of data files that make up the 
currently selected database.  
 
Selecting one will show a brief 
description in the Description 
window. 
 
Click „Select‟ to confirm use of the 
selected database for grouping. 
Click „Export‟ to export the selected 
table.  Users will be prompted to 
supply filename and location. 
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3.7 Single Spell Grouping 

Tools > Single Spell… 
 
Single spell grouping enables grouping of individual, manually entered records.  This can be 
useful if exploring how certain combinations of clinical codes lead to different HRGs being 
derived.  A database and a matching RDF must be selected in the grouper‟s main screen.   
 
The Single Spell Grouping window: 

 
 
 
 
 
 
 
 

 Upper section displays Input  
 
 
 
 
 
 
 
 

 Middle section displays Output 
(HRGs etc.)  

 
 
 
 
 

 Lower section displays Errors.  
 
 
 

The Upper input section is populated with default values for the mandatory fields of the currently 
selected database.Data can be added or edited in the Value column.  The Enter key must be 
used to confirm adding or editing a value otherwise the grouper will ignore the new value.  
 
The Description column displays the code description when a valid code has been entered.  
 
Clicking on the Click to add record header bar will open an adjacent set of columns in which 
values for additional episodes can be entered to be grouped as part of the same spell. This is 
appropriate only when grouping Admitted Patient Care records where the spell HRG of a 
multi-episode spell may differ from the HRGs of the constituent records or for neonatal critical 
care where codes in one record can affect the HRG of a later record. 
 
Click Group to process the information entered and display the HRG and other derived 
information in the output section.  Please note that the order of clinical codes can affect the 
HRG derived.   
 
Where input data fails the grouper‟s validation, the HRG UZ01Z (Data Invalid for Grouping) is 
derived.  The field(s) that failed validation are displayed in the lower section of the window. 
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3.8 Log Display Area 

Any problems encountered during grouping are reported in the log display area located at the 
bottom of the grouper‟s main screen and should be checked after every grouping session. Any 
records that fail grouping due to data validation will be indicated in the „ungrouped‟ count.  
 
For Admitted Patient Care data, the number „ungrouped‟ in the log may not agree to the number 

of records in the _quality.csv output file. This is because the log shows the number of 

consultant episodes that failed validation but the quality file includes valid episodes that form 
part of spells containing episodes that failed validation i.e. some of the episodes in the 

_quality.csv output file are valid episodes that have been grouped. 

 

All comments displayed in the log display area are also added to the hrg.log text file in the 

grouper installation folder. 
 
The log display area is cleared when the grouper is closed. 

 

3.9 Grouper Priority 

The grouping process can use a large amount of processor time.  On some computers this can 
make other applications slow or unresponsive during grouping. To reduce impact on other 
applications, priority can be set using the radio buttons while the progress bar is displayed.   
 

 
Normal   Gives the grouper the same priority as other applications, other applications may 
  be slowed down while the grouper is running. 
 
Lower   Reduces processor usage and gives priority to other applications. 
 
Idle    Minimises the grouper‟s use of processing resources.  The grouper will only 
  process data when no other applications require processing resources. 
 
„Priority‟ can be changed for the current grouping run only, each time a file is processed „Priority‟ 
will automatically be set to „Normal‟. 
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3.10 Displaying Files 

Output files are in CSV (comma-separated) format and can be opened in a number of 
applications. 
 
Displaying Files in Microsoft Excel 

Usually, comma-separated files are associated with Excel which means that double-clicking a 

.csv file opens it in Excel. On computer systems where .csv files do not by default open in 

Excel, select „Open…‟ from Excel‟s „File‟ menu. When the „Open‟ dialog appears, select „Text 

Files‟ from the „Files of type‟ drop-down box; .csv files will be displayed in the file list. 

 
There is a limit to the number of 
rows in an Excel worksheet, the 
limit varies depending on the 
version of Excel. When opening a 
file where the number of rows 
exceeds the available number of 
worksheet rows, Excel will display 
an error message such as 
„Problems During Load‟. 
 
 
 
 
 
 
 
 

The Internal File Viewer 
The grouper provides a file viewer which can be used to view grouper output files. To access 
the file viewer, select Display File from the Tools menu. This opens an „open‟ form.  
To display output files in the „open‟ form‟s file list ensure that the „Files of type‟ drop-down list is 

set to “*.inp,*.out,*.csv,*.txt” 

  
When a file is opened, the fields displayed are restricted to those defined in the RDF that is 
currently active. This means that in order to use „Display File‟ to view the columns that grouping 
appends during file processing, an RDF must be created that includes those fields. 
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The field names and any „Picture‟ and „Extract‟ values from the RDF are applied. 

 

 

 

 

 

 

 

 

 

 

 

 
Double-clicking on a record within the display opens it in the Single Spell Grouping screen. 
The space beneath each field name allows the user to enter filter criteria to limit the records 
displayed, based on one or more starting characters. Pressing the Enter key activates the filter. 
The screenshot below shows the display file feature with an active filter: 

 

 

Multiple criteria can be added by entering values in more than one column. 

To remove a filter criterion, delete it and press the Enter key. 
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3.11 Picture 

 
Picture is a feature within the RDF that can be used to specify the inclusion or exclusion of 

specific character positions from input fields.  It allows the user to provide filtering instructions 

for each field by describing a character template. During processing the application will apply 

this template to the field by selectively ignoring characters in specific positions within a field.  

 
An “A” character indicates a character position to be included in grouping and a full-stop 

indicates a character position to be ignored in grouping. This „picture‟ is then imposed on the 

field before grouping, meaning that the modified version of the field contents is processed by the 

grouper. 

To use Picture, enter a character template in the „Picture‟ column of the Record Definition File 

using the RDF editor. 

 Characters should not be separated by spaces 

 Quotation marks should not be used 

 Can be used with alpha and numeric fields  

 Where the number of characters in the field exceeds the number of characters specified in 
Picture, the application will implement the Picture on the left-most portion of the field. For 
this reason, care should be taken when using Picture with variable length fields as this may 
lead to unpredictable results. 

 Picture is applied prior to data validation. 

 Picture applies to file processing only; it does not affect single-spell grouping. 
 

Example 1 AAA.AA Characters 1, 2, 3, 5 and 6 are used. Character 4 is ignored 

Example 2 .A.AAA  Characters 2, 4, 5 and 6 are used.  Characters 1 and 3 are 

    ignored 

Example 3 .A.  Character 2 is used.  Characters 1 and 3 are ignored 

Example 4 AA    Characters 1 and 2 are used (Note that full stops are not required 

    if consecutive characters from the beginning of the field are the 

    only characters required). 
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3.12 Extract 

 
Extract is a feature of the Record Definition File (RDF) that can be used to make the grouper 
ignore specific characters in input fields, irrespective of character position. 

 

Entering one or more characters in the „Extract‟ column of the RDF using the RDF editor will 
instruct the grouper that any occurrence of any of these characters in that field should be 
ignored in grouping.  (Note: Commas can not be excluded because the input data files are 
comma-separated). 
 
The application does not consider a series of characters as a string of characters to be ignored 
as a single entity. Each character entered is ignored wherever it appears in the input field. 
 

 The characters specified will be ignored wherever they appear in the input data field 

 There is no relation between the position of a character in the extract field and the input field 

 All occurrences of the characters are affected 

 Extract is applied prior to data validation 

 Extract applies to file processing only. it does not affect single-spell grouping 
 
Extract Field Examples 
The examples below are shown in quotation marks (“) to help identify the examples. Quotation 
marks should not be entered when using the Extract function (Unless a user wishes to „ignore‟ 
quotation marks).  
 
Example 1 
Entering an Extract character of “.” informs the application that all occurrences of a decimal 
place or full-stop should be ignored when processing that field. This is a convenient way to 
remove decimal points from a field in the input file. An input field containing the character string 
“abc…d” will be interpreted by the application as “abcd”. 
 
Example 2 
Entering the characters “+$” in this field informs the application that any occurrences of both the 
“+” character and the “$” character are to be ignored by the application when processing that 
field. An input field containing the character string “46+$$++” will be interpreted by the 
application as “46”. 



HRG4 Grouper Reference Manual v2.1.doc 

 
40 Copyright © 2011, The Health and Social Care Information Centre. All Rights Reserved. 

3.13 Using Command Line 

 
„Command line‟ refers to the character-based command shell user interface within Microsoft 
Windows. The grouper can process a file using the command line and parameters shown 
below. Mandatory parameters are enclosed within <angle brackets>; optional parameters are 
enclosed within [square brackets].  All parameters consist of a hyphen followed by a lower-case 
letter. 
 
The command line takes the following form: 
 
HRGGrouper -i<Input File> -o<Output File> -d<Record Definition File> 

-l<Grouping Logic> [-h] [-t] [-p] [-r<report filename>] 

 
Command line parameters: 

-i The path and filename of the input file. 

-o The path and filename of the output file. 

-d The path and filename of the record definition file. 

-l The grouping logic (see „Grouping Logic Parameter‟ below). 

-h Optional. Where present, indicates that the input file has a header row (field names). 

 Omit this parameter where the first row in the file is a data row. 

-t Optional. Where present, stops generation of field names in top row of output file.  

 If this parameter is omitted then each of the output files will contain a header row. 

-p Optional. Where present, sets the priority of the grouping process. The available values 

 are 1, 2 and 3.1=‟Normal‟ (grouper priority equal to that of other applications), 2=‟Lower‟ 
 (grouper yields to other applications), 3=‟Idle‟ (grouper only processes data when other 
 applications don‟t require processor time). 
 If this parameter is omitted, the priority is set to 1 („Normal‟). 

-r Valid in Reference Costs Grouper only. Optional. Where present, specifies one of 

 the built-in reports (see list in reports section below). The -r flag can be repeated to 
 specify the production of more than one report. The report names are the filenames of 
 .rgf files supplied as part of the grouper installation. See the Reports section of this 
 document for further information about the available reports. 
 If this parameter is omitted, reports are not produced. 

-? Optional. Where present, directs the grouper to list the available command line 

 parameters to the hrg.log file in the grouper program folder. This parameter cannot be 
 combined with other parameters. 
 
Where there are spaces in paths or filenames for parameter values, the parameter value must 
be enclosed within double-quote characters. 
 
Grouping Logic Parameter 
This parameter informs the grouper of the type of input data (e.g. Admitted Patient Care) to be 

processed. The parameter is the name one of the .tre files included with the grouper  

installation. 
 
Valid grouping logic parameters can be identified by using Windows Explorer to view the all the 

.tre files in the grouper application installation folder (typically a sub-folder of C:\Program 

Files\NHS IC\). Displaying the contents of the folder using the „Details‟ view (available from 

the „View‟ menu) and sorting the file list by „Type‟ will place all of the files of type „TRE File‟ 
together. 
 

The filenames of the .tre files consist of a prefix indicating the data type to which the file 

relates followed by an underscore character followed by an abbreviation indicating the grouper 

to which the file belongs (plus the .tre extension). 
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The data type to which a .tre file relates can be identified by the filename prefix; these are 

tabulated below 
 

Prefix Data Type 

apc_ Admitted Patient Care 

nap_ Non-Admitted Consultations 

em_ Emergency Medicine 

nrd_ Renal Dialysis (National Renal Dataset) 

acc_ Adult Critical Care 

ncc_ Neonatal Critical Care 

pcc_ Paediatric Critical Care 

 
Note: for the Local Payment grouper, the main part of the filename ends in the lower-case 
equivalent of LP as an abbreviation for „Local Payment‟; the penultimate character being the 
twelfth letter in the alphabet, not the numerical digit representing „one‟. 
 

The path to the .tre file must not be included in the -l parameter; the parameter should be 

the filename only (inclusion of the .tre extension is optional). The path is not required because 

the .tre file must be in the grouper‟s installation folder. 

 
Working Directory 
Before running the grouper from the command line, the working directory should be set to the 
directory of the appropriate grouper executable (HRGGrouper.exe). Use full path names for the 
input file, the output file and the record definition file where they are located in other directories. 
 
Grouping Messages 
Messages generated by the application while running in command-line mode (e.g. the number 

of records processed) are written to the hrg.log file in the grouper‟s installation folder.  

 
Command Error Messages 
Errors in the command line, such as specifying a non-existent input file, cause an entry to be 

created in the hrg.log file. In addition, a non-zero exit code is returned. This means that a 

batch file or command file can check whether a command has passed validation by checking 

the value of %errorlevel%. 

 
Using the Command Line in a Batch File 
The following shows how a command line instruction to run the grouper can be incorporated into 
a batch file. This example is for a reference costs grouper and thus the command line includes 

the -r parameter. Grouper-specific text for the installation folder and the grouping logic 

parameter are represented by placeholder text surrounded by hash (#) symbols. 
 
@echo off 

C: 

cd "Program Files\NHS IC\#grouperFolderName#" 

HRGGrouper -i "C:\HRG Data\apc100.CSV" -o "C:\HRG Data\output.csv" 

-d "HRG4_sample_APC.rdf" -l #groupingLogic.tre# -h -p 3 

-r APCFCEReport001.rgf -r APCFCEReport002.rgf 

IF %ERRORLEVEL% NEQ 0 echo Error in command, please check hrg.log  

pause 
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4 Field Usage in Grouping 

The following tables provide brief descriptions about how fields are used by the grouper 

Admitted Patient Care 

PROCODET Spell identification and sorting 

PROVSPNO Spell identification and sorting 

EPIORDER 
Sorting: sort order is used to help determine dominant procedure/diagnosis in 
spell grouping 

STARTAGE Age splits etc. 

SEX Additional checks within the grouping logic for some conditions 

CLASSPAT Reference cost reports 

ADMISORC Unbundled Paediatric and Neonatal transportation 

ADMIMETH Unbundled Paediatric and Neonatal transportation 

DISDEST 
In Subchapter DZ in COPD HRG 

Unbundled Specialist Palliative Care 

DISMETH 

Subchapter LB: Identifies live donor for kidney donation HRGs 

Subchapter PB Identifies stillbirths 

Unbundled Specialist Palliative Care 

Paediatric Critical Care 

EPIDUR Length of stay splits 

MAINSPEF Unbundling: Specialist Palliative Care 

NEOCARE Unbundling: Paediatric and Neonatal transportation 

TRETSPEF 
Unbundling: Specialist Palliative Care and Paediatric and Neonatal 
Transportation 

DIAG_01 Drives diagnosis-based grouping and multiple trauma 

DIAG_02 Drives diagnosis-based grouping for Dagger/Asterisk codes 

DIAG_02 - NN Determination of Complexity and Comorbidity splits 

OPER_01 - N 
All procedures are used in unbundling, multiple trauma procedures and 
procedure based grouping 

CRITICALCAREDAYS Modifies episode duration used in grouping 

REHABILITATIONDAYS 
Modifies episode duration used in grouping. 
Used as a multiplier in unbundled rehabilitation HRG output 

SPCDAYS 
Modifies the episode duration used in grouping. 
Used as a multiplier in unbundled Specialist Palliative Care HRG output 

 
Non-Admitted Consultations 

STARTAGE Used extensively in grouping - age splits etc 

SEX Used as additional validation within grouping logic for some conditions 

MAINSPEF Used in unbundling - Specialist Palliative Care 

TRETSPEF Used in unbundling - Specialist Palliative Care 

FIRSTATT Used to establish default HRG where procedure-based grouping does not 

OPER_01 - NN All procedures are used in unbundling and procedure based grouping 

 
Emergency Medicine 

INV_01 - NN All investigation codes are used in grouping 

Treat_01 - NN All treatment codes are used in grouping 
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Renal Dialysis (National Renal Dataset) 

RENALMOD Primary driver for grouping used to identify the type of dialysis 

RENALSITE 
Secondary grouping driver for most of the HRGs; identifies treatment location 
(e.g. hospital) 

RENALACCESS Sub-divides HRGs based on type of dialysis access 

HBV 

These fields drive fine-tuning of HRG derivation HCV 

HIV 

AGE Used as an HRG modifier 

 
Adult Critical Care 

CCUF Validation only 

All others Used in grouping logic 

 
Neonatal Critical Care 

CCLocalID Local use in record identification and sorting 

CCDate Local use in record identification and sorting 

DisDate Used in conjunction with DisMeth 

CCUF Used in validation and some HRG escalation logic 

Age_Days Low values can acts as an HRG escalator 

Dis_Meth Death can act as an HRG escalator 

GestLen Low values can acts as an HRG escalator 

PerWt Low values can acts as an HRG escalator 

CCAC_01 - NN The main driver for HRG grouping of each day's record 

OPER_01 - NN Not used 

 
Paediatric Critical Care 

CCLocalID Local use in record identification and sorting 

CCDate Local use in record identification and sorting 

DisMeth Death can act as an HRG escalator 

CCUF Other than validation, not used 

CCAC_01 - NN The main driver for HRG grouping of each day's record 

OPER_01 - NN Identifies use of certain drugs 

DIAG_01 - NN Identifies burns and isolation 
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5 Output Files 

Throughout this section, [name] will be used to indicate a filename supplied by the user during 
processing.  The remainder of the file name is a standard suffix appended by the grouper. 
 
A single input file produces a number of output files although, depending on the requirements of 
the user, not all output files may be used. In most cases an output field appears in more than 
one file thus enabling users to select the files that best suit their needs. 
 
Output files are produced as comma-separated text which can be opened using Microsoft Excel. 
In some cases, large files may exceed the maximum number of rows allowed to be displayed, 
resulting in an error message such as “File not loaded completely”. Output files can be opened 
with a variety of applications, including Windows Notepad. 
 
Relational Output Files 
Relational output files are provided to support users wishing to import output data to a relational 

database.  These files, identified by “_rel” in the filename, should be used as a collection 

rather than in isolation.  Each file contains row number references which enable the files to be 
linked.  Repeated items such as unbundled HRGs, specialised service codes and error 
messages are represented as additional rows rather than columns.  A relational quality output 
file is produced in addition to a non-relational quality file for all data types.  Specific relational 
output files are produced for APC and NAC data.   
 
‘RowNo’ Field 
„RowNo‟ can be used to link relational output files within a database.  For example, for APC, the 

output file [name]_ub_rel.csv displays the unbundled HRGs for each output row. The field 

„RowNo‟ contains the row number of the matching output record in the file [name]_FCE.csv.  

 
Depending on the role of a file in relation to another file, „RowNo‟ may not contain consecutive 
values i.e. there may be values missing.  This is by design. For example, the „RowNo‟ values in 

file [name]_flag_rel.csv  will contain non-consecutive values where the input data contains 

multi-episode spells.  Certain non-relational files include the „RowNo‟ of other output data files to 

facilitate record linking. This applies to [name]_spell.csv and [name]_quality.csv.  If 

these files are imported into a relational database, the „RowNo‟ fields can be used as the basis 
from which to derive keys to allow the relationship between these records to be represented. 
 
‘Iteration’ Field 

„Iteration‟ appears in the [name]_quality_rel.csv and [name]_ub_rel.csv relational 

output files, it is used to distinguish between occurrences of quality messages or unbundled 
HRGs, respectively, that belong to the same episode. „Iteration‟ contains the ordinal number of 
each occurrence of the type of item.  There is no significance to the numerical values of 
„Iteration‟ as the values are assigned in order, numbered „1‟, „2‟, „3‟ etc. 
 
„Iteration‟ may be thought of as the relative column number of the row referred to by „RowNo‟. 
Where input row results in more than one data quality message, there will be a separate row for 

each data quality message in [name]_ub_rel.csv, distinguished by a different number in 

„Iteration‟.  Where an input row generates more than one unbundled HRG there will be a 

separate row in [name]_ub_rel.csv, each distinguished by a different number in „Iteration‟. 

 
An APC input file containing two data quality issues on row five would be displayed as follows: 

[name]_FCE.csv in row five there are two data quality messages. 

[name]_quality_rel.csv contains two rows related to the above: 

In the first row, „RowNo‟ = 5 and „Iteration‟ = 1. 
In the second row, „RowNo‟ = 5 and „Iteration‟ = 2. 
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5.1 Admitted Patient Care 

There are eleven output files. 

 

File Name/Field Name Description 

[name].csv A list of other output files; this file is for validation only. 

[name]_sort.csv A copy of the input data after it has been sorted into Provider Code, 
Spell Number and Episode Number order prior to grouping. 

 <input data> All of the input data, including any non-mandatory fields. 

 RowNo The row number of the record after sorting. 

[name]_FCE.csv Contains both episode and spell output fields. 
The spell fields are repeated for each episode in the spell; care must 
be taken to avoid double-counting when using spell fields. 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo The row number of the record after sorting 

 FCE_HRG The episode HRG 

 GroupingMethodFlag The grouping method used for the spell. P=Procedure driven, 
D=Diagnosis driven, M=Multiple trauma, G= Global exception 

 DominantProcedure The dominant procedure used for procedure-based grouping 

 FCE_PBC Programme Budgeting Code for the episode 

 CalcEpidur The calculated episode duration. This is the input Episode duration 
minus the number of days in the input field CRITICALCAREDAYS, 
REHABILITATIONDAYS and SPCDAYS. 

 ReportingEPIDUR This field is populated by Reference Costs groupers only. 
The episode duration used when generating reports. The value in this 
field is the same as CalcEpidur except in the case of ordinary 
admissions (Patient Classification=1) where CalcEpidur is zero. In 
these cases the value is incremented from the CalcEpidur value of 
zero days to one day. This reflects the fact that the reports produced 
by the Reference Costs groupers are tailored specifically for 
Reference Costs requirements. 

 FCETrimpoint This field is populated by Reference Costs groupers only. 
The trimpoint for the episode HRG. 

 FCEExcessBeddays This field is populated by Reference Costs groupers only. 
The number of days by which the episode duration exceeds the 
trimpoint. 

 SpellReportFlag Used in Reference Costs groupers when generating reports from 
grouped data 

 SpellHRG The spell HRG 

 SpellGroupingMethodFlag The grouping method used for the spell. P=Procedure driven, 
D=Diagnosis driven, M=Multiple trauma, G= Global exception 

 SpellDominantProcedure The dominant procedure for the spell 

 SpellPDiag The primary diagnosis used when spell grouping 

 SpellSDiag The first secondary diagnosis used when spell grouping 

 SpellEpisodeCount The number of episodes in the spell 

 SpellLOS The spell duration used for grouping. This is the total of the 
CalcEpidur fields for the episodes in the spell. 

 ReportingSpellLOS This field is populated by Reference Costs groupers only. 
The spell duration used when generating reports. This is the total of 
the ReportingEPIDUR fields for the episodes in the spell. 

 SpellTrimpoint This field is populated by Reference Costs groupers only. 
The trimpoint for the spell HRG. 

 SpellExcessBeddays This field is populated by Reference Costs groupers only. 
Number of days by which the spell duration exceeds the trimpoint. 
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File Name/Field Name Description 

 SpellCCDays The number of critical care days in the spell 

 SpellPBC Programme Budgeting Code for the spell 

 UnbundledHRGs Variable number of fields containing unbundled HRGs (episode level) 
Unbundled HRGs appended to the end of each record. 
There may be zero, one or more unbundled HRGs per record. 
No significance to the order in which unbundled HRGs are output. 
For Specialist Palliative Care and Rehabilitation, unbundled HRGs, 
where there is more than one daily HRG, field consists of an HRG, 
followed by an asterisk, followed by number of days, rather than HRG 
repeated for every day; e.g. VC18Z*20 indicates VC18Z for 20 days. 

[name]_spell.csv Contains one row per spell. 
Includes candidate Specialised Service Codes (SSCs), Best Practice 
Tariff (BPT) codes and other flags generated for the spell. 

 RowNo Matches the RowNo field of the first episode record for the spell in 
the [name]_FCE.csv file. 

 PROCODET The organisation code from the input file 

 PROVSPNO The hospital provider spell number from the input file 

 SpellHRG The spell HRG 

 SpellGroupingMethodFlag The grouping method used for the spell. “P”=Procedure driven, 
“D”=Diagnosis driven, “M”=Multiple trauma, “G”= Global exception 

 SpellDominantProcedure The dominant procedure for the spell 

 SpellPDiag The primary diagnosis used for spell grouping 

 SpellSDiag The first secondary diagnosis used for spell grouping 

 SpellEpisodeCount The number of episodes in the spell 

 SpellLOS The spell duration used for grouping 

 ReportingSpellLOS This field is populated by Reference Costs groupers only. 
The spell duration used when generating reports. 

 SpellTrimpoint This field is populated by Reference Costs groupers only. 
The trimpoint for the spell HRG. 

 SpellExcessBeddays This field is populated by Reference Costs groupers only. 
The number of days by which the spell duration exceeds the trimpoint 

 SpellCCDays The number of critical care days in the spell 

 SpellPBC Programme Budgeting Code for the spell 

 SpellSSC_Ct Number of distinct SSCs produced for the spell 

 SpellSSC1-SpellSSC7 Candidate Specialised Service Codes for the spell. 

Grouper does not check eligibility - please refer to Department of 
Health guidance for organisational eligibility. Populated by payment 
groupers only. 

 SpellBP_Ct Number of distinct BPTs produced for the spell 

 SpellBP1 to SpellBP7 Candidate Best Practice Tariff codes for the spell. 

Grouper does not check eligibility - please refer to Department of 
Health guidance for organisational eligibility. Populated by payment 
groupers only. 

 SpellFlag_Ct   Number of distinct other flags produced for the spell 

 SpellFlag1 to SpellFlag7 Candidate other flags for the spell. 

Grouper does not check eligibility - please refer to Department of 
Health guidance for organisational eligibility. Populated by payment 
groupers only. 

 UnbundledHRGs All unbundled HRGs produced for episodes in the spell. 

No significance to the order in which unbundled HRGs are output 
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File Name/Field Name Description 

[name]_quality.csv Contains a row for each episode that contains an error. 

Where one or more episodes within a multi-episode spell contain 
errors, all the episodes from the spell, including those that do not 
contain errors, are included in the quality file. Thus there are records 
in the quality file that do not include error messages. 

 <input data> All of the input data for the FCE, including any non-mandatory fields, 
are reproduced in the output. 

 RowNo Matches RowNo field of the related record in the [name]_FCE.csv file 

 Error Message A variable number of fields, each consisting of Code Type, Code and 
Error Message, separated by pipe ( | ) symbols. 

[name]_FCE_rel.csv  Episode-level output in relational form 

 RowNo Matches the RowNo field of the related record in the [name]_FCE.csv 
file 

 FCE_HRG The episode HRG. 

 GroupingMethodFlag The grouping method used for the spell. “P”=Procedure driven, 
“D”=Diagnosis driven, “M”=Multiple trauma, “G”= Global exception 

 DominantProcedure The dominant procedure used for procedure-based grouping 

 FCE_PBC Programme Budgeting Code for the episode 

 CalcEpidur The calculated episode duration. This is the input Episode duration 
minus the number of days in the input fields CRITICALCAREDAYS, 
REHABILITATIONDAYS and SPCDAYS. 

 ReportingEPIDUR This field is populated by Reference Costs groupers only.  The 
episode duration used when generating reports. The value in this 
field is same as CalcEpidur except in the case of ordinary admissions 
(Patient Classification=1) where CalcEpidur is zero. In these cases 
the value is incremented from the CalcEpidur value of zero days to 
one day, reflecting that reports produced by reference costs groupers 
are tailored specifically for reference cost requirement. 

 FCETrimpoint This field is populated by Reference Costs groupers only. 

The trimpoint for the episode HRG. 

 FCEExcessBeddays This field is populated by Reference Costs groupers only. 

The number of days by which the episode duration exceeds the 
trimpoint. 

 SpellReportFlag Used in Reference Costs groupers when generating reports from 
grouped data. 

[name]_spell_rel.csv Contains Spell-level output in relational form; one row per spell 

 RowNo Matches RowNo field of related record in the [name]_FCE.csv file. 

 PROCODET The organisation code from the input file 

 PROVSPNO The hospital provider spell number from the input file 

 SpellHRG The spell HRG 

 SpellGroupingMethodFlag The grouping method used for the spell. P=Procedure driven, 
D=Diagnosis driven, M=Multiple trauma, G= Global exception 

 SpellDominantProcedure The Dominant procedure for the spell 

 SpellPDiag The primary diagnosis used when spell grouping 

 SpellSDiag The first secondary diagnosis used when spell grouping 

 SpellEpisodeCount The number of episodes in the spell 

 SpellLOS The spell duration used for grouping 

 ReportingSpellLOS This field is populated by Reference Costs groupers only. 

The spell duration used when generating reports. 
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File Name/Field Name Description 

 SpellTrimpoint This field is populated by Reference Costs groupers only. 

The trimpoint for the spell HRG. 

 SpellExcessBeddays This field is populated by Reference Costs groupers only. 

Number of days by which the spell duration exceeds the trimpoint. 

 SpellCCDays The number of critical care days in the spell. 

 SpellPBC Programme Budgeting Code for the spell. 

[name]_quality_rel.csv Relational format includes row for each episode that contains an error 

 RowNo Matches the RowNo field of the related record in the 
[name]_quality.csv and [name]_FCE.csv files. 

 Iteration The ordinal number of the quality message 

 Code Type The type of code that has failed validation 

 Code The value of the code that has failed validation. Blank where the code 
is missing from the input data. 

 Error Message Description of the error 

[name]_flag_rel.csv This file is populated by payment groupers only. 

Includes all distinct Specialised Service Codes (SSCs), Best Practice 
Tariff (BPT) codes and other flags generated for the spell.  

Where a spell does not generate SSCs, BPT codes or Flags this file 
will contain no records for that spell. 

 RowNo Matches the RowNo field of the related record in the [name]_FCE.csv 
and [name]_spell.csv files. 

 PROCODET The organisation code from the input file 

 PROVSPNO The hospital provider spell number from the input file 

 Iteration The ordinal number of the SSC, BPT or other flag 

 SpellFlag Includes all distinct Specialised Service Codes (SSCs), Best Practice 
Tariff (BPT) codes and other flags generated for the spell.  Grouper 
does not check eligibility - please refer to Department of Health 
guidance for organisational eligibility. 

[name]_ub_rel.csv The unbundled HRGs. There are no entries for episodes that do not 
have any unbundled HRGs. 

 RowNo Matches RowNo field of related record in the [name]_FCE.csv file 

 Iteration The ordinal number of the unbundled HRG 

 UnbundledHRGs The unbundled HRGs. 

No significance to the order in which unbundled HRGs are output. 

[name]_summary.csv A single-row file containing details about the grouping session 

 Grouper Version Version of the grouper that produced the output files 

 Database Version Grouper‟s internal HRG database version 

 FCE Count Number of episodes submitted 

 Spell Count Number of spells submitted 

 FCE Error Count Number of episodes having errors 

 Spell Error Count Number of spells having errors 

 Run Start Date/Time Date and time that the grouping session started 

 Run End Date/Time Date and time that the grouping session finished 

 Input Filename Path and filename of the input file 

 Output Filename Path and filename selected by the user 

 RDF path and name Path and filename of the Record Definition File used for grouping 
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5.2 Non-Admitted Consultations 

There are seven output files 

File Name/Field Name Description 

[name].csv A list of other output files used for validation only 

[name]_attend.csv The main grouped output file 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo. The row number of the record 

 NAC_HRG The attendance HRG 

 GroupingMethodFlag Grouping method used for spell P=Procedure driven, G= Global exception 

 DominantProcedure The dominant procedure used for procedure-based grouping 

 AttendSSC_Ct   Number of distinct SSCs produced for the attendance 

 AttendSSC1-AttendSSC5 Candidate Specialised Service Codes for attendance. 

Grouper does not check eligibility - please refer to Department of Health 
guidance for organisational eligibility. Populated by payment groupers 
only. 

 AttendBP_Ct Number of distinct BPTs produced for the attendance 

 AttendBP1-AttendBP5 Candidate Best Practice Tariff codes for attendance. 

Grouper does not check eligibility - please refer to Department of Health 
guidance for organisational eligibility. Populated by payment groupers 
only. 

 AttendFlag_Ct   Number of distinct other flags produced for the attendance 

 AttendFlag1-AttendFlag5 Candidate other flags for the attendance. 

Grouper does not check eligibility - please refer to Department of Health 
guidance for organisational eligibility. Populated by payment groupers 
only. 

 UnbundledHRGs A variable number of fields containing unbundled HRGs (at episode level) 
appended to the end of each record. No significance to the output order. 

[name]_quality.csv Contains one row for each attendance that contains errors 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo Matches RowNo field of the related record in the [name]_attend.csv file 

 Error Message A variable number of fields, consisting of Code Type, Code and Error 
Message, separated by „pipe‟ ( | ) symbols. 

[name]_attend_rel.csv Output in relational form 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo Matches RowNo field of the related record in the [name]_attend.csv file 

 NAC_HRG The attendance HRG 

 GroupingMethodFlag Grouping method used for spell P=Procedure driven, G= Global exception 

 DominantProcedure The dominant procedure used for procedure-based grouping 

[name]_quality_rel.csv All error messages in relational form. None for attendances without errors 

 RowNo Matches RowNo field of related record in the [name]_quality.csv and 
[name]_attend.csv files 

 Iteration The ordinal number of the quality message 

 Code Type The type of code that has failed validation 

 Code The code that failed validation. Blank if code missing from input data 

 Error Message Description of the error 
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File Name/Field Name Description 

[name]_flag_rel.csv This file is populated by payment groupers only. 

Includes all distinct Specialised Service Codes (SSCs), Best Practice 
Tariff (BPT) codes and other flags generated for the attendance.  

Where an attendance does not generate SSCs, BPT codes or Flags this 
file will contain no records for that attendance. 

RowNo Matches RowNo field of the related record in the [name]_attend.csv file 

Iteration The ordinal number of the SSC, BPT or other flag 

AttendFlag Includes all distinct Specialised Service Codes (SSCs), Best Practice 
Tariff (BPT) codes and other flags generated for the attendance.  Grouper 
does not check eligibility - please refer to Department of Health guidance 
for organisational eligibility. 

[name]_ub_rel.csv Unbundled HRGs. No entries for attendances without unbundled HRGs. 

 RowNo Matches RowNo field of the related record in the [name]_attend.csv file 

 Iteration The ordinal number of the unbundled HRG 

 UnbundledHRG Unbundled HRG.  No significance to the output order 

[name]_summary.csv A single-row file containing details about the grouping session 

 Grouper Version The version of the grouper that produced the output files 

 Database Version The grouper‟s internal HRG database version 

 Attendance Count The number of records submitted 

 Attendance Error Count The number of records having errors 

 Run Start Date/Time The date and time that the grouping session started 

 Run End Date/Time The date and time that the grouping session finished 

 Input Filename The path and filename of the input file 

 Output Filename The path and filename selected by the user 

 RDF path and name The path and filename of the Record Definition File used for grouping 
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5.3 Emergency Medicine 

There are five output files. 

File Name/Field Name Description 

[name].csv A list of other output files.  This file is for validation only 

[name]_attend.csv The main grouped output file 

 <input data> All of the input data including any non-mandatory fields 

 RowNo The row number of the record 

 EM_HRG The attendance HRG 

[name]_quality.csv Contains a row for each input record that has errors 

 <input data> All of the input data including any non-mandatory fields 

 RowNo Matches the RowNo field of the related record in the [name]_attend.csv 
file 

 Error Message A variable number of fields, consisting of Code Type, Code and Error 
Message, separated by „pipe‟ ( | ) symbols. 

[name]_quality_rel.csv All of the error messages in relational form. 

There are no entries for records that do not contain errors. 

 RowNo Matches the RowNo field of the related record in the [name]_quality.csv 
and [name]_attend.csv files 

 Iteration The ordinal number of the quality message 

 Code Type The type of code that has failed validation 

 Code The value of the code that has failed validation. Blank where the code is 
missing from the input data 

 Error Message Description of the error 

[name]_summary.csv A single-row file containing details about the grouping session 

 Grouper Version Version of the grouper that produced the output files 

 Database Version Grouper‟s internal HRG database version 

 Attendance Count Number of records submitted 

 Attendance Error Count Number of records having errors 

 Run Start Date/Time Date and time that the grouping session started 

 Run End Date/Time Date and time that the grouping session finished. 

 Input Filename Path and filename of the input file 

 Output Filename Path and filename selected by the user 

 RDF path and name Path and filename of the RDF used for grouping 
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5.4 Renal Dialysis (National Renal Dataset) 

There are five output files 

 

File Name/Field Name Description 

[name].csv A list of other output files, used for validation only 

[name]_renal.csv The main grouped output file 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo The row number of the record 

 NRD_HRG The HRG for the dialysis record 

[name]_quality.csv Contains one row for each record that contains errors 

 <input data> All of the input data for the record, including any non-mandatory fields 

 RowNo Matches RowNo field of the related record in the [name]_renal.csv file 

 Error Message A variable number of fields, each consisting of Code Type, Code and 
Error Message, separated by pipe ( | ) symbols 

[name]_quality_rel.csv All of the error messages in relational form 

There are no entries for records that do not contain errors 

 RowNo Matches the RowNo field of the related record in the [name]_quality.csv 
and [name]_renal.csv files 

 Iteration The ordinal number of the quality message 

 Code Type The type of code that has failed validation 

 Code Code that failed validation (Blank if code missing from input data) 

 Error Message Description of the error 

[name]_summary.csv A single-row file containing details about the grouping session 

 Grouper Version Version of the grouper that produced the output files 

 Database Version Grouper‟s internal HRG database version 

 NRD Record Count Number of records submitted 

 NRD Record Error Count Number of records having errors 

 Run Start Date/Time Date and time that the grouping session started 

 Run End Date/Time Date and time that the grouping session finished 

 Input Filename Path and filename of the input file 

 Output Filename Path and filename selected by the user 

 RDF path and name Path and filename of the RDF used for grouping 
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5.5 Adult Critical Care 

There are five output files. 

File Name/Field Name Description 

[name].csv A list of other output files, used for validation only 

[name]_acc.csv The main grouped output file 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo The row number of the record 

 ACC_HRG The unbundled HRG for the ACC period. All ACC HRGs are unbundled. 

 Calc_CC_Days The number of CC days calculated as: 

CC Discharge Date - CC Start Date + 1 

This will be set to -1 if there are problems with the dates 

 CC_Warning_Flag Flag to indicate result of validation of CC Start Date and CC Discharge 
Date. Date validation failure does not prevent HRG derivation. 

„Blank‟ indicates valid date.  

„F‟ indicates date validation failure; applied if any of the following are true: 

• Calc_CC_Days = -1. This indicates that: 

 » CC Discharge Date is Before CC Start Date 

 » CC Start Date or CC Discharge Date: 

  - Is blank 

  - Is not a valid date 

  - Does not match the required format 

• CCL2 Days + CCL3 Days > Calc_CC_Days 

• ARSD + BRSD > Calc_CC_Days 

• ARSD + BRSD > CCL2 Days + CCL3 Days 

[name]_quality.csv Contains one row for each record that contains errors. 

 <input data> All of the input data for the record, including any non-mandatory fields. 

 RowNo Matches the RowNo field of the related record in the [name]_acc.csv file. 

 Error Message Variable number of fields, consisting of Code Type, Code and Error 
Message, separated by pipe ( | ) symbols. 

[name]_quality_rel.csv All error messages in relational form.  No entries for records without errors. 

 RowNo Matches the RowNo field of the related record in the [name]_quality.csv and 
[name]_acc.csv files 

 Iteration The ordinal number of the quality message 

 Code Type The type of code that has failed validation 

 Code Code that failed validation (blank if code missing from input data) 

 Error Message Description of the error 

[name]_summary.csv A single-row file containing details about the grouping session. 

 Grouper Version Version of the grouper that produced the output files. 

 Database Version Grouper‟s internal HRG database version. 

 ACC Period Count Number of records submitted 

 Periods Error Count Number of records having errors 

 Run Start Date/Time Date and time that the grouping session started 

 Run End Date/Time Date and time that the grouping session finished 

 Input Filename Path and filename of the input file 

 Output Filename Path and filename selected by the user 

 RDF path and name Path and filename of the RDF used for grouping 
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5.6 Neonatal Critical Care 

There are six output files. 

File Name/Field Name Description 

[name].csv A list of other output files; this file is for validation only 

[name]_sort.csv A copy of the input data after it has been sorted 

 <input data> All input data, including any non-mandatory fields 

 RowNo Row number of the record after sorting 

[name]_ncc.csv The main grouped output file 

 <input data> All input data, including any non-mandatory fields 

 RowNo Row number of the record after sorting 

 NCC_HRG Unbundled HRG for the NCC day (All NCC HRGs are unbundled) 

[name]_quality.csv Contains one row for each record that has errors 

 <input data> All of the input data, including any non-mandatory fields 

 RowNo Matches RowNo field of related record in the [name]_ncc.csv file 

 Error Message A variable number of fields, each consisting of Code Type, Code 
and Error Message, separated by pipe ( | ) symbols 

[name]_quality_rel.csv All of the error messages in relational form 

 RowNo Matches the RowNo field of the related record in the 
[name]_quality.csv and [name]_ncc.csv files 

 Iteration Ordinal number of the quality message 

 Code Type Type of code that has failed validation 

 Code Code that failed validation (blank if code missing from input data) 

 Error Message Description of the error 

[name]_summary.csv A single-row file containing details about the grouping session 

 Grouper Version Version of the grouper that produced the output files 

 Database Version Grouper‟s internal HRG database version 

 NCC Record Count Number of records submitted 

 NCC Record Error Count Number of records having errors 

 Run Start Date/Time Date and time that the grouping session started 

 Run End Date/Time Date and time that the grouping session finished 

 Input Filename Path and filename of the input file 

 Output Filename Path and filename selected by the user 

 RDF path and name Path and filename of the RDF used for grouping 
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5.7 Paediatric Critical Care 

There are six output files. 

File Name/Field Name Description 

[name].csv A list of other output files; this file is for validation only 

[name]_sort.csv A copy of the input data after it has been sorted. 

 <input data> All input data including any non-mandatory fields 

 RowNo Row number of the record after sorting 

[name]_pcc.csv The main grouped output file. 

 <input data> All input data including any non-mandatory fields 

 RowNo Row number of the record after sorting 

 PCC_HRG Unbundled HRG for the PCC day. All PCC HRGs are unbundled 

[name]_quality.csv Contains one row for each record that has errors 

 <input data> All input data including any non-mandatory fields 

 RowNo Matches RowNo field of related record in the [name]_pcc.csv file 

 Error Message A variable number of fields, each consisting of Code Type, Code 
and Error Message, separated by pipe ( | ) symbols 

[name]_quality_rel.csv All of the error messages in relational form 

 RowNo Matches RowNo field of related record in the [name]_quality.csv 
and [name]_pcc.csv files 

 Iteration Ordinal number of the quality message 

 Code Type Type of code that has failed validation 

 Code Code that failed validation (blank if code missing from input data) 

 Error Message Description of the error 

[name]_summary.csv A single-row file containing details about the grouping session 

 Grouper Version Version of the grouper that produced the output files 

 Database Version Grouper‟s internal HRG database version 

 PCC Record Count Number of records submitted 

 PCC Record Error Count Number of records having errors 

 Run Start Date/Time Date and time that the grouping session started 

 Run End Date/Time Date and time that the grouping session finished 

 Input Filename Path and filename of the input file 

 Output Filename Path and filename selected by the user 

 RDF path and name Path and filename of the RDF used for grouping 
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5.8 Undefined Groups and Error Reporting 

As part of the grouping process, the grouper carries out validation checks on many of the 
mandatory input fields. Where one or more fields fail validation, the grouper derives the HRG 
UZ01Z (Data Invalid for Grouping).   
 
For single-episode spells, where the episode fails validation, the error HRG is derived at both 
episode and spell level.  For multi-episode spells that contain a mixture of episodes that pass 
validation and episodes that fail validation, the error HRG is derived for each episode that fails 
validation and for every episode in the spell at spell level. 
 
Details of all errors encountered are reported in a grouper output file called the quality file. The 
listings in Section 5: Output Files includes a description of the quality file for each of the data 
types processed by the grouper.  Section 2: File Preparation provides further information 
regarding the field validation by the grouper.   
 
Error Message Format 
Error messages in the quality file are displayed in three sections separated by a pipe character.  
Where an error is due to the absence of a code the „code‟ section of the error message is blank. 
 
Code Type|Code|Error Description 
 

 „Code Type‟ identifies the field or field type 

 „Code‟ is the unrecognised value (where a value exists)  

 „Error Description‟ explains the nature of the error 
 
e.g. ICD|P102|UZ03 - Diagnosis Conflicts with Age in DIAG_01 
 
Error Types 
 
1) Field Validation Errors are generated where field values are missing or are outside of the 
accepted range of values.  Example error messages of this type are:  
 
ICD||Primary diagnosis is blank 
ICD|XX68|Code not recognised in DIAG_01 
OPCS|C992|Code not recognised in OPER_02 
 
2) Spell Validation Errors are generated as a result of cross checks across records in a spell. 
For example, where consistency checks for sex code or age are failed:  
 
SEX||Not the same in all episodes in the spell 
AGE||Falls in FCEs in this Spell 
 
3) Clinical Coding Errors occur due to the use of clinical codes that do not exist in the coding 
system, violate clinical coding convention or are not useful resource indicators for HRG 
grouping.  Clinical coding errors produce error messages that contain error category codes.  
 
Error Categories  
Error Categories are used mainly for clinical coding errors. Details of clinical coding validation 
can be found in the chapter summary for Subchapter UZ, Undefined Groups.  Critical care 
grouping error descriptions also include error category codes. 
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UZ01, Invalid Primary Diagnosis indicates an invalid primary diagnosis 

Diagnosis code is present but should not be used in a primary position according to clinical coding 
conventions 

ICD|Z509|UZ01 - Invalid Primary Diagnosis in DIAG_01 

(Z509: Care involving use of rehabilitation procedure, unspecified)  

UZ02, Poorly Coded Primary Diagnosis indicates a poorly coded primary diagnosis 

Diagnosis code is valid as a primary diagnosis but is too vague to determine the resource use. 

ICD|T140|UZ02 - Poorly Coded Primary Diagnosis in DIAG_01 

(T140: Superficial injury of unspecified body region) 

UZ03, Diagnosis Conflicts with Age 

A paediatric primary diagnosis has been recorded for an adult patient (age 19 years and over).  

ICD|P704|UZ03 - Diagnosis Conflicts with Age in DIAG_01 

(P704: Other neonatal hypoglycaemia) 

UZ04, Diagnosis Conflicts with Anatomical Site  

Indicates an invalid combination of primary diagnosis and anatomical site. This only applies to specific 
musculoskeletal codes entered at 5th digit level. 

ICD|M6607|UZ04 - Diagnosis Conflicts with Anatomical Site in DIAG_01 

(M6607:  Rupture of popliteal cyst-Ankle/foot) 

UZ05, Invalid Dominant Procedure 

Indicates invalid dominant procedure (e.g. an anatomical site) and includes the entire Y (methods of 
operations) and Z (anatomical sites) codes and also a number of codes in the main body system chapters. 

OPCS|Y841|UZ05 - Invalid Dominant Procedure in OPER_02 

OPCS|W450|UZ05 - Invalid Dominant Procedure in OPER_02 

(Y841: Gas and air analgesia in labour) 

(W540: Conversion from previous prosthetic replacement of articulation of bone NEC) 

UZ06, Poorly Coded Procedure  

Indicates a dominant or unbundled procedure that is too vague and unspecific to determine resource use 
from an HRG design perspective.  

OPCS|A579|UZ06 - Poorly Coded Procedure in OPER_02 

OPCS|U019|UZ06 - Poorly Coded Procedure in OPER_01 

(A579: Unspecified operations on spinal nerve root) 

(U019: Unspecified diagnostic imaging of whole body) 

UZ11, Not a Neonatal Period of Care  

This is a general purpose grouping error for Neonatal Critical Care, generated when the input record does 
not meet any of the criteria in the neonatal critical care grouping algorithm. 

UZ12, Not a Paediatric Period of Care  

This is a general purpose grouping error for Paediatric Critical Care, generated when the input record does 
not meet any of the criteria in the paediatric critical care grouping algorithm.  

UZ13, ACC Grouping Error  

This is a general purpose grouping error for Adult Critical Care, generated when the input record does not 
meet any of the criteria in the adult critical care grouping algorithm. 

UZ21, CCAC Inappropriate in NCC 

Generated when the input record is deemed inappropriate for the Neonatal Critical Care HRG algorithm 

UZ22, CCAC Inappropriate in PCC 

Generated when the input record is deemed inappropriate for the Paediatric Critical Care HRG algorithm 

 
Notes 

 If an error is found in a record, the grouper continues the validation process in order to 
group all errors together 

 In Admitted Patient Care data, primary diagnosis is always validated. 

 All clinical codes are validated against the grouper‟s internal database of codes 
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The HRG4 Documentation Suite 
The HRG4 Documentation Suite is a comprehensive resource of supporting materials, 
designed to assist users in understanding the design concepts, logic and practical use of 
the HRG4 Grouper.  Below is a list of the various HRG4 documents which are available to 
download from the Casemix Service website www.ic.nhs.uk/casemix 
 
 
 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

HRG4 Companion is a starting point and general reference for new and existing users, 
providing an introduction to HRGs, groupers, HRG4 design concepts and grouping logic and 
useful links to further information.   

Casemix Design Framework defines the rules and criteria followed when designing 
Casemix classification systems. 

 

HRG4 Chapter Listings provide details, listed by HRG, of the codes that can map to those 
groups, along with details of flags, lists and complications and comorbidities  

 

HRG4 Code to Group User Manual serves as an introduction to using the Code to Group 
workbook to perform manual grouping.  It also details some basic design concepts and 
provides worked examples of a variety of different grouping scenarios. 

 

 

HRG4 Code to Group workbook provides details on all mappings between primary 
classification codes and HRGs. Also detailed within the workbook are the logic conditions 
required to generate the HRGs. 

 

HRG4 Chapter Summaries provide an overview of the scope, composition and grouping 
logic of individual subchapters along with illustrative worked examples.  They also include 
updates on the changes within subchapters. 

 

HRG4 Roots workbook identifies new HRGs, deleted HRGs and changes to existing HRG 

Labels between designs using colour-coding. 

HRG4 Summary of Changes provides an overview of the main changes between the 
current HRG4 grouper design and its predecessor. 

 

HRG4 Grouper Reference Manual provides full instructions on how to prepare and group 
data using the HRG4 Grouper software application. 

 

http://www.ic.nhs.uk/casemix


 
 
 

 
 
 

 
 


